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Packaging SNN IP

* Find Tools/Create and Package New

Ele Edit Flow Tools Reports Window Layout View  Help

Synthesis Complete  +

= B o X Default Layout ~
Flow Navigator PROJECT MANAGER - SNN 2? %
v PROJECT MANAGER .
Sources ? 00K X Project Summary 200X
£ settings
a =z £ + & Overview | Dashboard
Add Sources
~ = Design Sources (f) ~
Lenguags Tempites » = Verilog Header (2 settings  Edit
<F 1P Catalog > @ 5 SNN_top (SN 2)
» = Memory File (3) eate and Package New IP
v IPINTEGRATOR > Constraints (1)
Create Block Design > @ Simulation Sources p Create and Package New IP
» = Utility Sources
k Design Vlvﬁl?o This wizard can be used to accomplish following tasks:
te Block Design Package a new IP for the Vivado IP Catalog
This wizard will guide you through the process of creating a new vivado IP using source files and information from
your current project, block design or specified directory.
v SIMULATION
Run Simulation Hierarchy  Libraries  Compile Order Create a new AX14 Peripheral
This wizard will guide you through the process of creating a new AXI4 peripheral which includes HDL, driver,
a software test application, IP Integrator VIP simulation and debug demonstration design.
Properties
v RTLANALYSIS
> Open Elaborated Design
v SYNTHESIS
P Run Synthesis
> Open Synthesized Design
tan object to see pr
v IMPLEMENTATION
P RunImplementaticn [EsEE]
v
> plemented Desigr iA XI LI NX Click Next to continue No errars or warnings
. v
~ PROGRAM AND DEBUG Tel Console | Messages | Log | Reports 2 _O00
¥ Generate Bitstream - | a
Qa = 2 +
> Open Hardware Manager Name Constraints  Status WNS TNS WHS THS TPWS Total Power FailedRoutes LUT FF BRAMs URAM DSP  Start Elapsed  RunStrategy Report Strategy
~ o synth_1 constrs_1 synth_design Complete! 8515 274 200 0 0 9/13/23,1:35PM  00:01:47 Flow AreaOptimized_high* (Vivado Synthesis 2019) Vivado Synthesis Defa
impl_1 constrs_1 Not started Vivado Implementation Defaults (Vivado Implementation 2019)  vivado Implementatio
< b
Package your project and additional files to reuse as a piece of IP

9/19/2023 Ngo-Doanh Nguyen



Packaging SNN IP (2)

« Choose “Package your current project” & Finish

Ele Edit Flow Tools Reports Window Layout View  Help

= LR I - B

Synthesis Complete  +

Default Layout ~
Flow Navigator PROJECT MANAGER - SNN 2? %
~ PROJECT MANAGER .
Sources ? 00K X Project Summary 200X
£ settings
a =z £ + & Overview | Dashboard
Add Sources
~ = Design Sources (f) ~
Language Templztes 5 & Verilog Header (2] Settings  Edi
<F 1P Catalog > @ 5 SNN_top (SN 2)
» = Memory File (3) eate and Package New IP
v IPINTEGRATOR > Constraints (1)
Create Block Design > [ Simulation Sources Create Peripheral, Package IP or Package a Block Design
R > = Utlity Sources Please select one of the following tasks. [
te Block Design
v SIMULATION | Packaging Options
Hierarch Libraries  Compile Order
Run Simulation v “ | @) Package your current project
Use the project as the source for creating a new IP Definition.
Properties
v RTLANALYSIS
> Open Elaborated Design Package a specified directory
Chaose a directory as the source for creating a new IP Definition,
v SYNTHESIS
P Run Synthesis Create AX14 Peripheral
> Open Synthesized Design Create a new AXI4 peripheral
tan object to see pr Create an AX14 IP, driver, software test application, IP Integrator AXI4 VIP simulation and debug demonstration design,
v IMPLEMENTATION
P RunImplementaticn [EsEE]
> plemented Desigr No errors or warnings
. v
~ PROGRAM AND DEBUG Tel Console | Messages | Log | Reports 2 _O00
¥ Generate Bitstream - | a
Qa = 2 +
Open Hardware Manager a
> op 9 Name Constraints  Status WNS TNS WHS THS TPWS Total Power FailedRoutes LUT FF BRAMs URAM DSP  Start Elapsed  RunStrategy Report Strategy
~ o synth_1 constrs_1 synth_design Complete! 8515 274 200 0 0 9/13/23,1:35PM  00:01:47 Flow AreaOptimized_high* (Vivado Synthesis 2019) Vivado Synthesis Defa
impl_1 constrs_1 Not started

Vivado Implementation Defaults (Vivado Implementation 2019)  vivado Implementatio

3
Package your project and additional files to reuse as a piece of IP

9/19/2023 Ngo-Doanh Nguyen



Packaging SNN IP (3)

« Choose “Review and Package”. Package IP. Exit Vivado.

3 Edit Flow Tools Reports Window Layout View  Help

1

Flow Navigator
v PROJECT MANAGER
£ settings
Add Sources
Language Templates
<F 1P Catalog

Edit Packaged IP

<

IP INTEGRATOR

Create Block Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

> Open Elaborated Design

<

SYNTHESIS
P Run Synthesis

> Open Synthesized Design

<

IMPLEMENTATION

P RunImplementation

> Open Im

mented Design

~ PROGRAM AND DEBUG
¥ Generate Bitstream

> Open Hardware Manager

9/19/2023

W oo X
PROJECT MANAGER - SNN

Sources ? 00X
a = £ + o
- Design Sources (7)
» = Verilog Header (2]
> @ 2 SNN_top (SNN_tc
5 o IPXACT (1)

» = Memory File (3)

> = Constraints (1)

» = Simulation Sources
» = Utility Sources

Properties ? _0O0O X

ties

Tel Console | Messages | Log | Reports | DesignRuns  x
a =% + %

Name Constraints ~ Status WNS
~ « synth_1 constrs_1 synth_design Complete!

impl_1 constrs_1 Not started

Synthesis Complete  +

TNS WHS THS TPWS Total Power

FalledRoutes LUT FF BRAMs URAM DSP Start
8515 274 290 0 o

Ngo-Doanh Nguyen

9/13/23, 1:35 PM

Default Layout ~
? X
Project Summary x| PackageIP-SNN_top  x oo
Packaging Steps Review and Package
~ Identification summary
+~/  Compatibility Display name: SNN_top_v1_0
Description:  SNN_top_v1_0
File Groups
Roct directory: fhome/doanh/Work/FPGA_SNN
~  Customization Parameters
+/ Ports and Interfaces
+ Addressing and Memory
After Packaging

+/ Customization GUI

Create archive of IP - jhome/doanh/Wark/FPGA_SNN/SNIN_processor_SNN_top_1.0.zip

Review and Package edit

1P will be made available in the catalog using the repository -

Jhome/doanh/Work/FPGA_SNN

Edit packaging settings

Package
?2-0C

Elapsed  RunStrategy
00:01:47 Flow_AreaOptimized_high* (Vivado Synthesis 2019)

Report Strategy
Vivado Synthesis Defa

Vivado Implementation Defaults (Vivado Implementation 2019)  vivado Implementatio



Overview

1.

2. SoC Integration with MicroBlaze

3.
4.
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SoC Integration (1)

« Create a new Vivado project. Choose xc7a100tcsg324-1

File  Flow Tools Window Help Q- Quick

VIVADO' £ XILINX,

HLx Editions

New Project

Quick Start

Create Project > Choose a default Xilinx part or board for your project [
Open Project >

Open Example Project >

Parts | Boards

Reset Al Filters
TaSkS Category:  All - Package: | All v Temperature: | All v
Family: Al ~v | speed: | Al ~ | Static power: | Al v
Manage IP >
Open Hardware Manager > Search: | O xc7a100tcs « | (4matches)
B SR 2 Part. IOPinCount AvailableIOBs LUT Elements  FlipFleps  Block RAMs  Ultra RAMs  DSPs  GbTr
xC7a100tcsg324-3 324 210 63400 126800 135 0 240 0
xc7a100tcsg324-2 324 210 63400 126800 135 0 240 0
. x7al00tcsg324-2L 324 210 63400 126800 135 0 240 0
Lea rnlng Center 324 210 63400 126800 135 0 240 0
Documentation and Tutorials >
Quick Take Videos >
Release Notes Guide >
< >

Tcl Console

New Project Wizard will guide you through the process of selecting design sources and a target device for a new project.

9/19/2023 Ngo-Doanh Nguyen



SoC Integration (1)

« Create a new Vivado project. Choose xc7a100tcsg324-1

3 Edit Flow Tools Reports Window Layout View  Help Q- Quick A
[T - )

PROJECT MANAGER - SNN

Flow Navigator

v PROJECT MANAGER |
Sources ? 00X Project Summary
£ settings
a =z £ + & Overview | Dashboard
Add Sources

= Design Sources (6)
Language Templates » = Verilog Header (2) Settings  Edit
SN,

» = Memory File (3)

<F 1P Catalog > @~ SNN_top

eate and Package New IP

v IPINTEGRATOR > Constraints (1)
Create Block Design > @ Simulation Sources p Create and Package New IP
» = Utility Sources
Vlvﬁl?o This wizard can be used to accomplish following tasks:
Package a new IP for the Vivado IP Catalog
This wizard will guide you through the process of creating a new vivado IP using source files and information from
your current project, block design or specified directory.
v SIMULATION
Run Simulation Create a new AXI4 Peripheral
T the process of creating a new AXI4 peripheral which includes HDL, driver,
a software test application, ator VIP simulation and debug demonstration design.
Properties
v RTLANALYSIS
> Open Elaborated Design
v SYNTHESIS
P Run Synthesis
> Open Synthesized Design
v IMPLEMENTATION
P RunImplementaticn
v
> mented Desigr iA XILI NX Click Next to continue
v PROGRAM AND DEBUG

Tel Console | Messages | Log | Reports

B8 Generate Bitstream

o T & +
Open Hardware Manager a
> op 9 Name Constraints  Status WNS TNS WHS THS TPWS Total Power FailedRoutes LUT FF BRAMs URAM DSP  Start Elapsed
~ « synth_1 constrs_1 synth_design Complete! 8515 274 290 0 0 9/13/23 1:35PM  00:01:47
impl_1 constrs_1 Not started
<

Package your project and additional files to reuse as a piece of IP

9/19/2023 Ngo-Doanh Nguyen

Run Strategy
Flow_AreaOptimized_high* (Vivado Synthesis 2019)

Vivade Implementation Defaults (Vivado Implementation 2019)

Synthesis Complete

v

Default Layout ~

?

200X

Report Strategy

X

Vivado Synthesis Defa

Vivado Implementatio
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SoC Integration (2)

Create new block design

Ele Edit Flow Tools Reports Window Layout View  Help Juick A Ready
= « | I - I Default Layout ~
Flow Navigator PROJECT MANAGER - SNN_UART_SoC ? X
~ PROJECT MANAGER .
Sources 2 _00 X Project Summary 200X
£ settings
a =z £ + & Overview | Dashboard
Add Sources
Design Sources ~
Language Templates 5 = Constraints Settings  Edit
<F 1P Catalog ~ = Simulation Sources Project name: SNN_UART SoC
sim_1 Project location: home/doanh/Work/FPGA_SNN/FPGA/SNN_UART SoC
~ IPINTEGRATOR > [= Utility Sources Product family: Artix-7
Create Block Design Project part: %C7a100tcsg324-1
Top medule name: Not defined
Target language: Verilog
simulator language: Mixed
v SIMULATION
Synthesis. Implementation
Run Simulation
ctafie: Please specify name of block design. CHatLs: Mt
~ RTL ANALYSIS GOz 20 ?-0ODBXx Messages: ’ Messages: No errors or warnings
» Open Elaborated Design o Part: part: xc7a100tcsg324-1
Strategy: Design name: design_1 Strategy: Vivado Implementation Defaults
v SYNTHESIS Report Strategy: Djrectory: o <Local to Project> v Report Strategy: Vivado Implementaticn Default Reports
Incremental synt ; . Incremental implementation: None
P Run Synthesis Specify source set: Design Sources ~
> thesized D P .
ties DRC Violations Timing
v IMPLEMENTATION Run Implementation to see DR Run Implementation to see tim
P RunImplementaticn
> mented Desigr Utilization Power
v
~ PROGRAM AND DEBUG Tcl Console | Messages | Log | Reports | DesignRuns  x 2 _O00
¥ Generate Bitstream - | a
Qa = 2 %
Open Hardware Manager a q
> op 9 Name Constraints  Status WNS TNS WHS THS TPWS TotalPower FailedRoutes LUT FF BRAMs URAM DSP  Start Elapsed RunStrategy Report Strategy
~ [+ synth_1 constrs_1 Not started Vivado Synthesis Defaults (Vivado Synthesis 2019) Vivado Synthesis Default Reports (Vivado Synthe
impl_1 constrs_1 Not started Vivado Implementation Defaults (Vivado 12019)  Vivade Impl, Default Reports (Vivado
< b

9/19/2023 Ngo-Doanh Nguyen



SoC Integration (3)

Add packaged SNN IP into project

Ele Edit Flow Tools Reports Window Layout View Help Quick Acce Ready
=, - E o W & T IP Integrator ~
Flow Navigator BLOCK DESIGN - design_1 2? %
Sources | Design % Signals 2_00 IPCatalog x ProjectSummary x| 2 O 5 Diagram 200 X
a =4 — - ¥ 2 C ®
Add Sources
design_1
Language Templates
IF 1P Catalog IP > Repository
Project Settings Add directaries to the list of repasitories. You may then
General selected repository. If an 1P is disabled then a tool-tip will lkel S 1P Repositories
v IPINTEGRATOR | )
Simulation =
Create Block Design o Recent: | © /home/doanh/Work/FPGA_SNN/FPGA v teodEds X=B T C
Elaboration 1P Repositories
Open Block Design Synthesis + Directory: /home/doanh/Work/FPGA_SNN
Generate Block Design Implementation > dev N
> et
v SIMULATION v P ~ [ home
(EposItol -
Run Simulation e doanh
Packager > [ Datasets
: > Desktoj
~ RTLANALYSIS Properties Tool Settings "
> [ Documents
> Open Elaborated Design Project > Downloads
1P Defaults N Music .
N— s s Find your packaged IP
Source File 5 Public
P Run Synthesis H
Display 5 [ Templates I t & S | t
WebTalk > [ videos Oca |On e eC
Help ~ [ Warlk
~ IMPLEMENTATION > Text Editor > |- 3D_stacking yield_rate
> [ Advanced_Computer_Architecture
P Run Implementation 3rd Party Simulators i --omputer.
> Colors
> Op mented Design FPGA_SNN
Selection Rules
Shortcuts
~ PROGRAM AND DEBUG Tel Console v

B8 Generate Bitstream -~
a =
THFO:
IHFO

> Open Hardware Manager

Messages

Log | Repor

sl 8B B O

[IP_Flow 19-234] Refreshing IF
[IP_Flow 19-1784] No user IP 1

> Strategies
> Remote Hosts

> Window Behavior

* INFO: [IP_Flow 10-2313] Loaded Vivac (7)
set_property coreContainer.enable 1 -

create_bd_design "design_1"

Wrote

update_compile_order -fileset sources_1

9/19/2023

Select directory

Apply ‘ Restore..,

BN |

1 </home/doanh/Work/FPGA_SHN/FPGA/SNN_UART_SoC/SNN_UART_SoC. sTcs/sources_1/bdrdesign_1/design_1.bd>

Ngo-Doanh Nguyen 12



SoC Integration (4)

 Successful added IP

Fle Edit Flow Tools Reports Window Layout Yiew Help = O QuickAcce Ready
=, >, & T 1
Flow Navigator BLOCK DESIGN - design_1 2
~ PROJECT MANAGER N . i
Sources | Design  x Signals 2_00 IPCatalog x ProjectSummary x| ? O O Diagram 200X
£ settings
o = B wa no »
Add Sources
design_1
Language Templates
IP > Repository
Project Settings Add directories to the list of repositories. You may then add additional IP to a [}
General selected repository. If an 1P is disabled then a tool-tip will alert you to the
~ IPINTEGRATOR T
Simulation
Create Bl -
Elaboration IP Repositories.
Open Design Synthesis F| =
Generate Block Design Implementation
- Jhome/doanh/Work/FPGA_SNN (Project)
Bitstream
v 1P
~ SIMULATION X - o Add Repository
Repository
Run Simul n
Packager 5 empty. Press the butt
- l 1 repository was added to the project
v RTLANALYSIS Properties Tool Settings o el el
s Opent Project
IP Defaults Repository
Board Repositor
v SYNTHESIS P " = =
Source File - e
Display * fhome/doanh/Work/FPGA_SNN ~
WebTalk v s
tto see propertia Help SNN_top_v1_D (SNIN:pr p:1.0) )
v IMPLEMENTATION » Text Editor “
Run Implementation 3rd Party Simulators
> Colors
> Op
Selection Rules
Shortcuts
~ PROGRAM AND DEBUG Td Console  x Messages | Log  Repor > Strategies 2_00
Generate Bitstream a = = N 8§ ® @ > Remote Hosts
> Open Hardwa update_compile_order -fileset source 'ndow Behavior P

set_property 1ip_repo_paths /home/c

update_ip_catalog

WARNING
RNING

9/19/2023

INFO: [IP_Flow 19-234] Refreshing IF
INFO: [IP_Flow 19-1708] Loaded user _ __

[IP_Flo
[IP_F

If you

Bl ] [ o ] [

the path for
domain name

y would be in a path adj

Ngo-Doanh Nguyen
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SoC Integration (5)

* Add SNN IP into Block Design

v

<

<

<

<

<

<

Fle Edt Fow Tools

B W«

PROJECT MANAGER
£F Settings
Add Sources
Language Templates

<F IP Catalog

IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

SIMULATION

Run Simulation

RTL ANALYSIS

5 OpenElaborated Design

SYNTHESIS
P Run Synthesis

> 0

thesized Design

IMPLEMENTATION

P RunImplementation

mented Design

PROGRAM AND DEBUG
¥% Generate Bitstream

> Open Hardware Manager

Window  Layout View Help Q- Quick Access
o & p W & X
BLOCK DESIGN - design_1 *

.0 g oA C U

Sources | Design x Signals 2 _00O IP Catalog  x Project Summary % 200 Diagram
a T H & Cores | Interfaces @ B O Q
design_1 - | - . »
- Q = = # 4 2 80
> SNN_top_0 (SN _ _011.0)
Search:
Name A1 AXI4  Status  License  V Search: | O SNN (1 match:
> User Repository (/ho Work/FPGA_SNN 7 SNN_top.v1_0
~ = Vivado Repository

> Alliance Partners 2

> = Alvec Card Management

> Audio Connectivity & Processing
> Automotive & Industrial

> = AXlInfrastructure

> (= AXIPeripheral

> AXIS Infrastructure

Properties ? 00K X > [ BaselP
-3 > Basic Elements ENTER to select, ESC to cancel, Ctrl+Q for IP details
> Communication & Networking ]
< 3
Details

TclConsole x Messages | Log | Reports | Design Runs

Q x & I B E @

INFO: [IP_Flow 19-234] Refreshing IP repositories

| INFO: [IP_Flow 19-17¢@] Loaded user IP repository '/home/doanh/Work/FPGA_SNN'.
| WARNING: [IP_Flo If you move the proj the path for :
WARNING: [IP_|
startgroup
create_bd_cell -type ip -vlnv SHN:processor:SNN_top:1.2 SNN_top_@
endgroup

| ELREYE YULI P UISLL G SIS I3 W | SUIE @3 8 LS Ul s

9/19/2023

Ngo-Doanh Nguyen

SNN_top_0

+ saxi
s_axl_aclk

s_axL_aresetn

SNN_top_v1_0

y would

a path adjacent to

Ready

IP Integrator v

00X

14



SoC Integration (6)

onfig SoC - MicroBlaze

Ele  Edit Flow Tools Reports Window Layout View Help Quick Acce: Ready
B X & F b, B & T b4 IP Integrator v
BLOCK DESIGN - design_1 * ? X
~ PROJECT MANAGER N
Sources | Design % Signals 2 _00 IPCatalog x ProjectSummary x| ? O I Diagram  x AddressEditor 200
£ Settings
a = -4 Cores | Interfaces F E oA C g &
Add Sources
design_1
Language Templates s ¥ micotfim
T 1P Catalog > T SNN_td
Automatically make cennections in your design by checking the boxes of the blocks to connect. Select a block on the left to display its
configuration options on the right. '
~ IPINTEGRATOR
Create Block Design -
; a = 2 Descripti +
Open Block Design - escription
~ [ All Automation (1 out of 1 selected) +
Generate Block Design s MicroBlaze connection automation generates local memory of selected size, and
[v] % microblaze 0 caches can be configured. MicroBlaze Debug Module, Peripheral AXI Interconnect,
Interrupt Controller, a clock source, Processor System Reset are added and connected
v SIMULATION as needed. A preset MicroBlaze configuration can also be selected, L
Run Simulation Information about the optians can be found in the taoltips.
SNN_top_0
~ RTLANALYSIS Block Prope! Options 4
|+ saxi
> OpenElaborated Design 7 microblaz Preset Microcontroller  + s_axi_aclk
s_axi_aresetn
Local Memor 128KB v
v SYNTHESIS Narmes Y —
SNN_top_v1_0
P Run Synthesis Parent nam Local Memory ECC None ~
> Opens Design Cache Configuration
Debug Module Debug Only v
~ IMPLEMENTATION
Peripheral AXI Port Enabled
P Run Implementation =
,,,,,,,,,,,, (] Interrupt Controller
> Open Implemented Design G
- eneral :
Clock Connection New Clocking Wizard (100 MHz)
~ PROGRAM AND DEBUG Tel Console e s _0ono
¥5 Generate Bitstream a =
> Open Hardware Manager WARNING: [IP_FIOW TY=3599] Tannot get the envITonment Oomain Name Varrable ToT the COMpONent VendoT name, SettIng the Vendor mame to 'user.org’ ~
| startgroup
! create_bd_cell -type ip -vlnv SNN:processor:SNN_top:1.8 SNN_top_@
. endgroup
| startgroup
. create_bd_cell -type ip -vInv xilinx.com:ip:microblaze:11.8 microblaze_o
| endgroup
: ~
< >

9/19/2023

Ngo-Doanh Nguyen
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SoC Integration (7)

« Config SoC - Clock Wizard

“ =

IP Integrator v
B 2
Clocking Wizard (6.0) '
| _ _ Change output
o Documentation IP Location *
1P Symbol  Resource Component Name | clicwiz. 1
() Show disabled ports
Clocking Optidhs  Output Clocks | MMEM Settings | Summary
icrbiaze 0 Jocal memory
& ~ microblaze O .
Clock Monitol
B MicroBl L owe +HJ i+
. T e ] -
[0 Enable Clock Monitoring icroblaze ™ | Rl s
Primitive
b -
® MmO PLL
Clocking Features. Jitter Optimization
N
[+] Frequency Synthesis ] Minimize Power alanced
- — \ M
) Phase Alignment (] Spread Spectrum Minimize Output ftter EN
v |I[4 cLeant_p dk_out’
= - . . aximize Input itter filtering
S (— () Dynamic Reconfig () Dynamic Phase Shift
[_J safe Clock Startup
Dynamic Reconfig Interface
Options
N

e e Change Source clock into
Primary clicint 5" ] 1co000 | 10.000-800000 U - |ooto Differential clock capabl

e — single ended clock

Change Clk Freq dule {Debug Only} ecc {None} local_mem {128KB} preset {Microcontroller}
- ~
into 50MHz. >

9/19/2023 Ngo-Doanh Nguyen 16



Edit  Flow Tools

Reports

w PROJECT MANAGER
£F Settings
Add Sources
Language Templates

<F IP Catalog

<

IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

5 OpenElaborated Design

<

SYNTHESIS
P Run Synthesis

> 0

thesized Design

<

IMPLEMENTATION

P RunImplementation

mented Design

v PROGRAM AND DEBUG

¥% Generate Bitstream

> Open Hardware Manager

9/19/2023

SoC Integration (8)

Config SoC - Add UART Lite

File
IR

Window layout View Help Juick Acce: Ready
® [ P, LI - TN IP Integrator w
BLOCK DESIGN - design_1 * ? X
Sources | Design  x Signals 2 _O0 1P Catalog x ProjectSummary x| 2 O & Diagram  x Address Editor 200
Qa = H - Cores | Interfaces Q a oo Q < E # C a9 T &*
design 1 Q = & # L | ¥ Designer Assistance available. Run Connectior
> = Interface Connections A
) Nets Search: |0 microblaze_0_loce
B | microblaze_0 D
> 9 avi_uartlite_0 (X1 Uartlite:2.0) Name A1 AxI4  Status  License V. I+ owwvs
> F clkcwiz1 > = User Repository (/ho VorkiFPGA_SNN search: | O UART (2 matches) J L
N 2 e OB =]
> % mdm_1 (M ule (MDM) ~ ' Vivado Repositary - H - LM + I} ] Bt 1
I , A uTIsse icroBlaze ™, e i i
* microblaze 0 (M 0) H
4 = > Alliance Partners = AXI Uartlite LAXL i
> [] microblaze_0_local_memory > Alveo Card Management 2
> T rstelkowiz 1_100M (P Reset5.0) > = Audio Connectivity & Processing MicroBlaze rst clk wiz 1
ot s axi_uartlite 0 — =
> SNN_top 0 (SNN. ! > = Automotive & Industrial = =
I Ik
> ¢ AXIInfrastructure + s Slowest_sync_cl
- - UART + ext_reset_in
> - AXIPeripheral SO aux_reset_in
s_axi_aresem - .
> [ AXIS Infrastructure mb_debug sys rst inter
Block Properties 2 00X > BaselP AXI Uartlite dem_locked pe
¥ cli_wiz_1 - - > [ Basic Elements clk_wiz_1 3 Processor Syste
> [ Communication & Networking M ENTER to select, ESC to cancel, Ctrl+Q for IP details SNN_top.
Name: el wiz_1 < £ reset ik out! |
q clkinl  locked S s axi
Parentname: design_1 Details sl
Clocking Wizard <_axi aresetn
mdm_1
SNN_top_v
MBDEBUG_O + |}
Debug S¥5 Rt
MicroBlaze Debug Module (MDM) N
< N
TclConsole x Messages |Log | Reports | Design Runs ?2_00
a x £ Il 8B E @
set_property -dict [list CONFIG.PRIM_IN_FREQ.VALUE_SRC USER] [get_bd_cells clk_wiz_1] ~

set_property -dict [list CONFIG.PRIM_SOURCE {Single_ended_clock_capable_pin} CONFIG.PRIM_IN_FREQ {5@.0@@} CONFIG.CLKOUT1_REQUESTED_OUT_FREQ {50.00} CONFIG.CLKINI_JITTER_PS {200.0} CONFIG.MMCM_CLKFBOUT_MULT_F {20.00@} CONFIG.MMCI
endgroup

startgroup

create_bd_cell -type ip -vinv xilinx.com:ip:axi vartlite:2.¢ axi_uartlite @

endgroup

set_property location {2 267 -166} [get_bd_cells axi uartlite @]

Ngo-Doanh Nguyen 17



SoC Integration (8)

« Config SoC - Config UART Lite

Ele Edit Fow Tools

~ PROJECT MANAGER

£F Settings

Language Templates

<

IP INTEGRATOR

Create Block Design

Open Bl

Generate Bl

Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

> OpenEl.

<

SYNTHESIS

<

<

PROGRAM AND DEBUG

rate Bitstream

> Open Hardware

9/19/2023

Window  Layout View Help Quick Acce Ready
| 3 * X X IP Integrator v

BLOCK DESIGN - design_1 *

Sources | Design  x Signals 2 _O0 IPCcatalog x ProjectSummary x| 2 O O Diagram  x AddressEditor 200
Q T L3 Cores | Interfaces @ Q = *
design_1 Q = &2 # 4 [ B 7 Designer Assistance available. Run Connection Automation
> Interface Connections -~
microblaze_0_loce
> Nets o Re-customize IP blaze 0
microblaze
> 4 axi_uartlite 0 (AXI Uartlite:2.0) |||+ oLms
clk wiz_1 .0) i m J |l|+ 1me
> dllwiz_ AXI Uartlite (2.0) / o + |l || -
> % mdm_1 2 Debug Module (MDM):3.2) MinOBlaze v e 4 [ 1 LMB_Clic
! SYS_Rst
» 9 microblaze_0 (MicroB| 0) . M_AXLDP +f* -
@ Documentation IP Location .
» [F] microblaze_0_local_memory
> rst_clk_wiz_1_100M (P — MicroBlaze rst_cl wiz 1
5 9% SNN_top_0 (SN () show disabled ports Component Name  ax_uartlite_0 r 2 —
L slowest_sync_clk
+ ext_reset_in
[ EE AxaCikFrequency 50 [10-300]MHz iy
b aux_reset in
Baud Rate 57600 - A mb_debug sys_rst inter
Block Properties 2 | L = | dem _locked pe
. Data Bits 8
axi_uartlite 0 4= clk_wiz_1 Processor Syste
. SNN_top.
N Pari —_—
Name: axi_uartlite_0 Y reset ck_out1
! clkinl  locked + s_axi
Parentname: design_1 imerrupt (® NoParity () odd () Even s_axi ack
Clocking Wizard s_axiaresetn
mdm_1
SNN_top_v.
MBDEBUG_O + |||
Debug_SY5_Rst
MicroBlaze Debug Module (MDM) )
| P
TelConsole  x Messages | Log  Reports 2 _O
Q T £ Il B B @
~

set_property -dict [list CONFIG.PRIM_IN_

set_property -dict [list CONFIG.PRIM_SOUnve fomnyre ey caven capaure gy Cunr o PR LN ey {2 Uy CUNr 0 CERUU T REQUES T EuowwtorRey - towswewrwwlF1G, CLKINI_JITTER_PS {200.8} CONFIG.MMCM_CLKFBOUT_MULT_F {20.8@0} CONFIG.MMCI
endgroup

startgroup

create_bd_cell -type ip -vinv xilinx.com:ip:axi_vartlite:2.8 axi_uartlite @

endgroup

set_property location {2 267 -166} [get_bd_cells axi_vartlite_o]

Ngo-Doanh Nguyen 18



SoC Integration (9)

« Config SoC - Auto Connection

Fle Edit Fow Tools Reports Window Layout View Help Q- Quick Acces Ready
=, >, & X » 1P Integrator v

Flow Navigator BLOCK DESIGN - design_1 * 2

~ PROJECT MANAGER
£+ Settings

Sources | Design x Signals 2 _0¢0 IP Catalog x ProjectSummary x| 2 O 4 Diagram  x Address Editor  x 200
Q = & Cores | Interfaces Q W o O $ 4 - F & 4 C U

design_1 al T & |# = [ N J Designer
> I Interface Connections

Run Connection

Language Templates

- ~
microblaze 0_locz

> Nets Search:
> ¥ axi_uartlite_0 (AXI Uartiite:2.0) Name Status  License DLMB
~ ¥ : : + ILMB
e 7 izt (C Run Connection Automation we  DIME + \|—J [ iy
Create Block Design > % mdm_1 (M 4ICFO Blaze 0 uwe 4| 1 s et
> % microblaze_0 (Vi 0) Automatically make connections in your design by checking the boxes of the interfaces to connect. Select an interface an the left to display WLAXLDP +1:: -
Open Blacl 3 [¥] microblaze_0_jocal memory its configuration options on the right.
Generate Block Design > % rst_clk_wiz_1_100M (P MicroBlaze
—CeE - ; rst_clicwiz_1_
> % SNN_top_0 0:1.0) i E o |
— slowest_sync_clk
~ SIMULATION « @) Rl Automation (6 out of 6 selected) L+ i
il & + ext_reset_in
Run Sim cilita, 2 ‘ i
) {} s_AxXT mb_debug sys rst inter
~ RTLANALYSIS Block Properties &) {} UART = & | dem _locked pe
> OpenEl ¥ axi_uartlite_0 v ) diowiz 1 ek wiz_1 Processor Syste
[¥] = clk_in1 SNN_top_
~ SYNTHESIS Name: axi_uartlite_0 ] = reset reset  clkoutl .
v ) rst_clk_wiz_1_100M clicinl locked + s_axi
Run S esis Parentname: design_1 = s_axi ack
o () = ext resetin Clocking Wizard s_axi aresetn
thesized Desigr ) SNN_top_0 mdm_1
) {0 s_axi SNN_top_v
It
. MBDEBUG_O + |||
Debug_S¥S_Rst
P ) CEPPEEPEETr ‘oBlaze Debug Module (MDM)
> OpenImplemented Desigr General [ET e ‘ ~
N
~ PROGRAM AND DEBUG Td Console  x Messages |Log | Repo 2 _0O0
Generate Bitstream > | a =
Qa =z £ I B E @
> Open Hardw r endgroup ~
| startgroup
| create_bd_cell -type ip -vlnv xilinx.com:ip:axi_uartlite:2.@ axi_uartlite_@
! endgroup
| set_property location {2 267 -166} [get_bd_cells axi_uartlite_g]
. set_property -dict [list CONFIG.C_S_AXI_ACLK_FREQ_HZ_d.VALUE_SRC USER] [get_bd_cells axi_uartlite 8]
| set_property -dict [list CONFIG.C_BAUDRATE {5768@} CONFIG.C_S_AXI_ACLK_FREQ_HZ {50000800} CONFIG.C_S_AXI_ACLK_FREQ_HZ_d {50}] [get_bd_cells axi_uartlite_@]
' -
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SoC Integration (10)

« Config SoC - Config Clock Pin

Q- Quick Acce

File  Edit Flow Tools Reports Window Layout View Help Ready
) >, & 3 ¥ IP Integrator v
Flow Navigator BLOCK DESIGN - design_1 * 2
w PROJECT MANAGER . R N
Sources | Design x Signals 2 _0O¢0 IPCatalog x ProjectSummary x| 2 O 4 Diagram  x Address Editor % 200
£+ Settings
Q = o Cores | Interfaces @ Q OB

Add Sources

EH m7

Language Templates

Customize Port

v IP INTEGRATOR intf_clock_v1_0(1.0) /¢
Create Block Design
Open Block Design
Component Name  clk_out1
Generate Block Design
v SIMULATION
Phase 0.000
Run Simu
Clk Domain clk
v RTLANALYSIS Associated Busif
> OpenEl
Associated Clken 0
v SYNTHESIS Associated Reset
Run Synthesis Associated Async Reset 0
> Ope ized Design
v IMPLEMENTATION
Run Implemer
> Open mented Design r

v PROGRAM AND DEBUG

Cancel

Generate Bitstream

> OpenHard

Slave segment </axi_uartlite_0/S_AXI/Reg> is being mapped into address space </microblaze @/Data> at <@x4060_0000 [ 64K 1>
apply_bd_automation -tule xilinx.com:bd rule:board -config { Manual Source {Auto}} [get_bd intf pins axi_uartlite @/UART]
INFO: [board_rule 188-188] create_bd_intf_port -mode Master -vlny xilinx.com:interface:uart_rtl:1.8 vart_rtl_8

INFO: [board_rule 186-18@] connect_bd_intf_net fuart_rtl 8 /axi_uartlite_8/UART

endgroup

set_property -dict [list CONFIG.CLK_DOMAIN {clk} CONFIG.FREQ_HZ {5@00@088}] [get_bd_ports clk_10@MHz)
regenerate_bd_layout

9/19/2023 Ngo-Doanh Nguyen
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File  Edit Flow Tools

5 W -

w PROJECT MANAGER
£+ Settings
Add Sources
Language Templates

T 1P Catalog

<

IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

5 OpenElaborated Design

<

SYNTHESIS

P Run Synthesis

ized Design

<

IMPLEMENTATION

» Run Implementation

v PROGRAM AND DEBUG

f Generate Bitstream

Open Hardware Manager

9/19/2023

Reports

SoC Integration (11)

Validate block design

Window  Layout  View  Help Q- Quick Acce: Ready
& & b, B H T IP Integrator ~
BLOCK DESIGN - design_1 * 2 x
Sources | Design x Signals ?2_0O0 IPCatalog x ProjectSummary x| 2 0O [4 Diagram < Address Editor  x 200
Q = H o Cores | Interfaces @ Q w9 Q = o
design_1 A = a »
Q= ¢ #F w1 |
» (= External Interfaces
> = Interface Connections Search:
v Ports Name A1 AXI4  Status  License W
[ clk_100MHz > = User Repository (/home Warl/FPGA_SNN A
[ resetrtl 0 v Vivado Repository
>0 Nets > = Alliance Parters
> T axi_uartlite 0 (AX .0) 5> = Alveo Card Management — u$ crcetase0fox s meencny
> % iz 1 (cle ) > = Audio Connectivity & Processing ‘ *'—”MiCrOBhZE | —
5 o bug Module (MDM): . . iir
> % mdm 1 (Micr & Debug Madule (MDM > Automotive & Industrial o Dy i QAT
> % microblaze_0 (MicroB 0 5 = AXlInfrastructure — J e tiace 0 e g
> ., m!croblaze,u,ax\,per\ph N 5 AXI Peripheral . —
> - AXIS Infrastructure =
External Port Properties. 2 _O00GX 5 © BaselP Jp—_
[ clk_100MHz - o > [ Basic Elements e
5 - Communication & Networking v > s
Name: clk_100MHz < 2
Direction: Input Details
Validate Design
Net T clk_100MHz_1
Frequency (MHz): |50
quency (MHz) o Validation successful. There are no errors or critical warrings in this design
General  Properties < >
Tel Console  x Messages  Log Reports | Design Runs 2 _00
Q T 2 Il B B @
set_property -dict [list CONFIG.CLK_DOMAIN {clk} CONFIG.FREQ HZ {50000080}1 [get_bd_ports clk_10@MHz] ~

regenerate_bd_layout
regenerate_bd_layout
validate_bd_design

ARNING

. [BD 41-702] Pr ommand
| WARNING: [BD 41-927] You can to confirm the value and re
CLK_DOMAIN=
: v
< >
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SoC Integration (12)

« Create HDL wrapper for block design

File  Edit Flow Tools Reports Window Layout View Help Q- Quick Acce:

Ready
=, ha B X & & » B & ¥ ¥ P Integrator -
o gato BLOCK DESIGN - design_1 2 x
w PROJECT MANAGER R R "
sources sign | Signals ?2_0O0 IPCatalog x ProjectSummary x| 2 0O [4 Diagram < Address Editor 200
£+ Settings
O = 5 + o Cores | Interfaces @ Q w9 Q R & * C o9 T -]
Add Sources
L = a »
Language Templates Q= = # 4 u
T 1P Catalog Search:
lation Sources (1) Name A1 AXI4  Status  License W
w IP INTEGRATOR sim_1(1) > User Repaository (/| Work/FPGA_SNN #

Create Block Design > [ utility Sources ~ - Vivado Repository

> Alliance Partners
Open Block Design

5 = Alveo Card Management
Generate Block Design

> Audio Connectivity & Processing

v SIMULATION Create HDL Wrapper

Run Simulation Hierarchy P Sources  Libraries  Compile Order > You can either add or copy the HDL wrapper file to the project. Use copy
> option if you would like to modify this file. '
~ RTLANALYSIS Source File Properties 2 _00nGX )
> Open Elaborated Design design_1 bd - o > Options
" >
« SYNTHESIS [ Enabled < | () Copy generated wrapper to allow user edits
: Detai
P Run Synthesis Location: thome/doanh/Work/FPGA_SNN/FPGA/SNN_U, (® Let Vivado manage wrapper and auto-update
> Ope ized Design Type: Block Designs
Part: xc7a100tcsg324-1
~ IMPLEMENTATION . st i
Size: 20.6 KB details
» Run Implementation
> Open mented Design General | Properties ¢
~ PROGRAM AND DEBUG TelConsole  x Messages |Log | Reports | Design Runs
it Generate Bitstream x - .
Q = £ Il B E i
> OpenHardware Manager ) validate_bd_design
: -702] jth paramete

hav

save_bd_design
| Wrote : </homefdoanh/Work/FPGA_SNN/FPGA/SNN_UART_SaC/SHN_UART_SoC.sIcs/sources_1/bd/design_1/design 1.bd>
Wrote : </home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SKN_UART_SoC . sTcs/sources_1/bd/design_1/ui/bd_1fSdefde.ui>

Generate HDL wrapper file and copy into project

9/19/2023 Ngo-Doanh Nguyen
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SoC Integration (13)

e Create Design Constraint

File  Edit Flow Tools

m oW - ]

Quick Acce

Reports

Window  Layout View Help

® & » B & T %

BLOCK DESIGN - design_1 *

v PROJECT MANAGER

Sources

Q

x Design | signals ?2_00 IPCatalog x ProjectSummary x| 2 O [% Diagram

Q Qe

% Address Editor  x

® o Q

£+ Settings
Cores | Interfaces

al z & #

4
+

® o C o
Add Sources

m”

Language Templates

> @ = design_1]
T 1P Catalog [ Constraints
EEET Add Sources
~ IP INTEGRATOR [ Simulation Sources (1)

Create Block Design > @ sim1(1) Add Sources

» = Utility Sources

’
Open Block Design V‘Vﬁgp This guides you through the process of adding and creating sources for your project rratiaze 0

Generate Block Design y
Add or create constraints

v SIMULATION () Add or create design sources 2

ficroBlaze “l/—

Run Simulation Hierarchy = IPSources  Libraries  Com

() Add or create simulation sources

v RTLANALYSIS Consti

int Set Properties

5 OpenElaborated Design constrs_1

« SYNTHESIS Default directory:  thome/doanh/WorkiFR
P Run Synthesis File count: 0
> ized Design Format: XDC

Target constraint file:
v IMPLEMENTATION

» Run Implementation

& XILINX

General  Properties

v PROGRAM AND DEBUG

TelConsole  x Messages  Log | Repo
5
i Generate Bitstream a'z & 1

B E i
Open Hardware Manager “) VHDL Output written to : /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SoC.srcs/sources_1/bd/design_1/hdl/design_1_wrapper.v

| add_files -norecurse /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SHN_UART_SoC.sIcs/sources_1/bd/design_1/hdl/design_1_wrapper.v
| regenerate_bd_layout
validate_bd_design -force
ARNING: [BD 41-702
WARNING: [BD 41-
CLK_DOMAIN=

ommand
You can

Specify and/or create source files to add to the project

9/19/2023 Ngo-Doanh Nguyen
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SoC Integration (14)

e Create Design Constraint

File  Edit Flow Tools Reports Window Layout View Help Q- Quick A

Ready
= W - B & & b E & X ¥ 1P Integrator ~
BLOCK DESIGN - design_1 * ? %
v PROJECT MANAGER . i i i
sources x Design |Signals ?2_00 IPCatalog x ProjectSummary x| 2 O @& Diagram  x Address Editor x 200
£# Settings
o T = 4+ o Cores | Interfaces @ @9 B oo Q s + ® * C 9 = -3
Add Sources
~ [ Design Sources (1) al = &2 # = @ »
Language Templates > @ = design_1_wrapper (design 1.\ ] ‘
T 1P Catalog [ Constraints Search: Q-
constrs_1
~ IP INTEGRATOR [ Simulation Sources (1)
Create Block Design > osim1 ) Add or Create Constraints
OpenBlock Design » = Utility Sources Specify or create constraint files for physical and timing constraint to add to your project. [ .
| mccbtase o ot memy
Generate Block Design . |
MicroBlaze ™!
Specify constraint set: constr: = _—
v SMusTON- o] o Create Constraints File micmtiaze.0.xe_pargn
Run Simulation Hierarchy | IPSources  Libraries  Com +‘ smopo
Create a new constraints file and add it to your project —
Constraint File  Location
v RTLANALYSIS Constraint Set Properties contraint.xdc <Local to Project
5 Open Elaborated Design constrs_1 e
- File type: " XDC -
| + |l s re0
« SYNTHESIS Default directory: thome/doanhWork/FP File name: | [contraint )’
P Run Synthesis File count: 0 File location: | = <Local to Project= w
> ized Design Format: *DC
Target constraint file:
v IMPLEMENTATION
Add Files
» Run Implementation
> General | Properties
p >%
~ PROGRAM AND DEBUG TclConsole  x Messages |log | Repd . 2 _O0@
it Generate Bitstream x a .
Q = £ I B E @
> Open Hardware Manager add_files -norecurse /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SoC.sTcs/sources_1/bd/design_1/hdl/design_1_wrapper.v ~

regenerate_bd_layout
validate_bd_design -force

value and

Specify and/or create source files to add to the project
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Eile  Edit Tools

=, W g

Flow

Reparts

X

w PROJECT MANAGER
£# Settings
Add Sources
Language Templates

T 1P Catalog

<

IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

5 OpenElaborated Design

<

SYNTHESIS

P Run Synthesis

ized Design

<

IMPLEMENTATION

» Run Implementation

v PROGRAM AND DEBUG

ft Generate Bitstream

Open Hardware Manager

9/19/2023

SoC Integration (15)

Define design constraints (Map

ing 1/O Pi

IN

Window  Layout View Help Juick Acce: Ready
& & b, B H T )3 1P Integrator ~
BLOCK DESIGN - design_1 * ? %
sources x Design |Signals ?2_00 IPCatalog x ProjectSummary x| 2 O @& Diagram  x AddressEditor x| constraintxdc  x
Q = 2 4+ & -4 Cores | Interfaces Q B B X [/ B 9
= Design Sources (1) alz 2 = =’ ot_property -dict { PACKAGE_PIN E3  TOSTANDARD LVCMOS33 } [get_ports { clk_10@MHz }]: =
» @ design.1_wrapper (design_ 1 ) Y set_property -dict { PACKAGE_PIN C2  TOSTANDARD LVCMOS33 } [get_ports { Teset_rtl_@ }]:
~ = Constraints (1) Search: set_property -dict { PACKAGE_PIN D10  IOSTANDARD LVCMOS33 } [get_ports { uart_rtl @ txd }
= constrs_1 (1) M A1 x4 status | License V. set_property -dict { PACKAGE_PIN A9  IOSTANDARD LVCMOS33 } [get_ports { uart_rtl ¢_rxd }
[ constraint.xdc > [ User Repository (/home. K/FPGA_SNN *~
[ Simulation Sources (1) ~ = Vivado Repository
>0 simt ) > = Alliance Partners
» 1= utility Sources 5> [ Alveo Card Management
> Audio Connectivity & Processing
> Automotive & Industrial
7777777777777777777777777777777777777777777777777777777 > AXIInfrastructure
Hierarchy | IPSources  Libraries  Compile Order > AXI Peripheral
> AXIS Infrastructure
Source File Properties 2 _O00GX 5 - BaselP
I constraint.xdc - o > [ Basic Elements
=l > - Communication & Networkina ~
) Enabled < >
Location: thome/doanh/Work/FPGA_SNN/FPGAISNN_U, Details
Type: XDC E‘
Size: 0.5KB
Modified: Today at 14:39:14 PM
]
General  Properties < 5
TelConsole  x Messages | Log | Reports | Design Runs 2 _O00
Q T 2 Il B B @
\ file mkdir /home/doanh/Work/FPGA_SNN/FPGA/SHN_UART_SoC/SNN_UART_SoC.sIcs/constrs_1 ~
. file mkdir /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SoC.srcs/constrs_1/new
| close [ open /home/doanh/Work/FPGA_SHN/FPGA/SHN_UART_SoC/SNN_UART_SoC.srcs/constrs_1/new/contraint.xdc w ]
! add_files -fileset constrs_1 /home/doanh/Work/FPGA_SHNN/FPGA/SHN_UART_SoC/SNN_UART_SoC.srcs/constrs_1/new/contraint.xdc
| export_ip_user_files -of objects [get_files /home/doanh/Work/FPGA_SKN/FPGA/SNN_UART_SoC/SNH_UART_SoC.sTcs/constrs_1/new/contraint.xdc] -no_script -reset -force -quiet
! remove_files -fileset constrs_1 /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SaC.stcs/constrs_1/nem/contraint.xdc
| add_files -fileset constrs_1 -norecurse /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SaC.srcs/censtrs_1/new/constraint . xdc
: v
< >
10 Insert XpC

Ngo-Doanh Nguyen
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SoC Integration (16)

« Synthesize + Implementation + Generate Bitstream

File  Edit Flow Tools Reports Window Layout View Help

=, ] X & ® b, B B % %

Quick Access

Running multiple block runs Cancel €

IP Integrator ~
Flow Navigator BLOCK DESIGN - design_1 2?2 X
~ PROJECT MANAGER i i - -
sources x Design | Signals ?2_0O0 IPCatalog x ProjectSummary x| 2 0O [4 Diagram  x Address Editor  x | constraintxdc  x <) [m] [g]
£+ Settings
o T = + o Cores | Interfaces @ Q w9 Q R & * C o9 T -]
Add Sources

~ [ Design Sources (1) ~ a »
Language Templates > @ .gdesignj,wrapper design_ ) allz =¥ '[:‘ =
<F 1P Catalog “ [ Constraints (1) Search:
~ [ constrs_1 (1) Name A1 AXI4  Status  License W
w IP INTEGRATOR [l constraintxde > User Repaository (/| Work/FPGA_SNN #

Create Block Design [ simulation Sources (1) ~ - Vivado Repository

> osim_1(1) > Alliance Partners
Open Block Design

> = Utility Sources 5> = Alveo Card Management - messes crcetase0fox s meencny

4 —
> - Audio Connectivity & Processing ‘ +|»—HMICI,OB|aze E e
=
> Automotive & Industrial Moo D Kk K
T wemaw [

i =

Generate Block Design

~ SIMULATION

> AXIInfrastructure

Hierarchy 1P Sources Libraries Compile Order > AXI Peripheral

Run Simulation

> AXIS Infrastructure

~ RTLANALYSIS Source File Properties 2 _OG X 5 = BaselP J— |
> Open Elaborated Design DD constraintxdc - o > Basic Elements e
= 5 - Communication & Networkina v + > usaro
) Enabled < >
Location: thome/doanh/Work/FPGA_SNN/FPGA/SNN_U, Details
Type: XDC E
Size: 0.5KB
Modified: Today at 14:39:14 PM
> Open mented Design
General  Properties < yn
~ PROGRAM AND DEBUG TelConsole  x Messages |Log | Reports | Design Runs 2 _00W
¥ Generate Bitstream x - w
Q = £ Il B E i
f design_1_rst_clk wiz_1_160M_@_synth_1: /home/doanh/Work/FPGA_SHN/FPGA/SHN_UART_SoC/SNN_UART_SoC.runs/design_1_rst_clk_wiz_1 10@M_2_synth_1/runme.log ~
| design_1_axi_uartlite_8_@_synth_1: /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART SoC/SHN_UART SoC.runs/design_1_axi_uartlite @ ®_synth_1/runme.log
| design_1_xbar_d_synth_1: /home/doanh/Work/FPGA_SHN/FPGA/SHN_UART_SoC/SNN_UART_SoC.Tuns/design_1_xbar_@_synth_1/Tunme.log
: synth_1: /home/doanh/Work/FPGA_SHN/FPGA/SHN_UART_SoC/SNN_UART_SoC. Tuns/synth_1/runme. log
| [Wed Sep 13 14:44:24 2623] Launched impl_1..
. Run output will be captured here: /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SoC.Tuns/impl_1/runme.log
launch_runs: Time (s): cpu = ©@:00:@7 ; elapsed = @8:@:05 . Memory (MB): peak = 7438.847 ; gain = 258,492 ; free physical = 7628 ; free virtual = 27958
: v
< >
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SoC Integration (16)

« Successful Implementation

Fle Edit Flow Tools Reports  Window  Layout View  Help write_bitstream Complete
X & p B H O & = )4 Default Layout -
Flow Navigator ] IMPLEMENTED DESIGN - xc7a100tcsg324-1
~ PROJECT MANAGER 2 5 -
Netlist Device
£+ Settings
=4 &
Add Sources
design_1_wrapper
Language Templates s Nets
<F IP Catalog > Leaf Cells
> 1] design 1
v IPINTEGRATOR
Create Block Design
Open Block Design
Generate Block Design
v SIMULATION
Run Simulation
v RTLANALYSIS
> Open Elaborated Design S GRS
I constraintxdc £
v SYNTHESIS ~
] Enabled
P Run Synthesis
Location: thame/doanh/Work/FPGA_SNN/FPGA/SN
> Open Synthesized Design
Type XDC E‘
v IMPLEMENTATION Size: 0.5 KB
P Runimplementation Maiified: Tordau af 14:30:14 P S
~ OpenImplemented Design General  Properties
Constraints Wizard
Edit Timing Constraints Timing
1 Report Timing Summary Q T = :DesignTimingSummary
Report Clock Networks General Information ~ by
Timer Settings Setup Hold Pulse Width
Report Clock Interaction .
Design Timing Summary Worst Negative Slack (WNS):  3.558 ns Worst Hold Slack (WHS): 0.023ns ‘Worst Pulse Width Slack (WPWS): 7.000 ns
Report Methodology Clock Summary Total Negative Slack (TNS): ~ 0.000 ns Total Hold Slack (THS): 0.000 ns Total Pulse Width Negative Slack (TPWS): 0.000 ns
Report DRC > (s CheckTiming (3) Number of Failing Endpoints: 0 Number of Failing Endpoints: 0 Number of Failing Endpoints 0
Report Noise > & Intra-Clock Paths Total Number of Endpoints: 12714 Total Number of Endpoints: 12714 Total Number of Endpoints: 4269
Inter-Clock Paths e .
~  All user specified timing constraints are met. v

Report Utilization === =
Timing Summary -impl_1 (saved)
& Ranart Bowar v



* Program

SoC Integration

FPGA

(17)

File  Edit Flow Tools Reports Window  Layout \View  Help Q- Quick Acce: Running route_design Cancel )
B X » o = ) 3 Dashboard - Default Layout v
HARDWARE - tcf/Digilent/210319B7CD3CA ? X
* v PROJECT MANAGER © There are no debug cors
¥ Settings
Hardware constraint.xdc 200 X%
Add Sources - .
Q = 2 x B B X /4 @m Q *
Language Templates E .
Name Status set_property -dict { PACKAGE_PTIN E3  TOSTANDARD LVCMOS33 } [get_ports { clk_18@MHz }]: ] ~
4 1P Catalog © 8 localhost (1) connected set_property -dict { PACKAGE_PIN (2  TOSTANDARD LVCMOS33 } [get_ports { reset_rt1_@ }]; #I
~ ¢ xilinx_tcf/Digilent/21031987CD3! Open set_property -dict { PACKAGE_PTN D18  TOSTANDARD LVCMOS33 } [get_ports { uart_rtl_e_txd }]; #
' v IP INTEGRATOR © @ xc7a10000 (1) Programmed set_property -dict { PACKAGE_PIN A9  IOSTANDARD LVCMOS33 } [get _ports { uart_rtl 0 xxd }1; =
Create Block Design JE XADC (System Mal
Open Block Design
Generate Block Design
T v SIMULATION
Run Simulation < b
A o ;
‘'« RTLANALYSIS Properties ? 00X
5 OpenElaborated Design o
Y v SYNTHESIS
P Run Synthesis
> Open Synthesized Design
* v IMPLEMENTATION
P Run Implementation
> Openimplemented Design
v
* ~ PROGRAM AND DEBUG < 2
Senerate Bitsream gl Console  x Messages | Serial I/O Links | Serial /0 Scans 2 _00
~ Open Hardware Manager T 2 1 B E @
open_hw_target -
INFO: [Labtoolstcl 44-466] Opening hw_target localhost:3121/xilinx_tcf/Digilent/218319B7C0D3CA
Program Device current_hw_device [get_hw_devices xc7a10t_]
Add Configuration Memory Dev refresh_fm_device -update_tm_probes false [lindex [get_m_devices xc7ale0t_e) @] )
* INFO: [Labtools 27-1434] Device xc7al8@t (JTAG device index = @) is programmed with a design that has no supported debug core(s) in it.
v
< >
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* Export

Flow

Tools Reports

Open Block Design

Generate Block Design

<

SIMULATION

Run Simulation

v RTLANALYSIS

> Open Elaborated Design

v SYNTHESIS
P Run Synthesis

> Open Synthesized Design

v IMPLEMENTATION
P RunImplementation
~ OpenImplemented Design
Constraints Wizard
Edit Timing Constraints
T Report Timing Summary
Report Clock Networks

Report Clock Interaction

Report Methodology
Report DRC

Report Utilization

% Report Power

¥4 schematic

~ PROGRAM AND DEBUG
¥ Generate Bitstream
~ Open Hardware Manager
Open Target
Program Device

Add Cenfiguration Memory D v

oftware Implementation (1)

Hardware platform for Software DevKi

window Layout View Help Q- Quick A
[ - T Dashboard

- lac inx_tcf/Digilent/210319B7CD3CA

@ There are no debug cores. Program device Refresh device

Hardware ?2 00 X constraint.xdc
Q = 2 o Q x B B X N/ B Q

set_property -dict { PACKAGE_PIN E3  IOSTANDARD LVCMOS33 } [get_ports { clk_1@0MHz }1:
set_property -dict { PACKAGE_PIN C2  IOSTANDARD LVCMOS33 } [get_ports { reset_rtl_® }]:

Name Status

~ I localhost

Connected
+ H e xilinx_tcfiDigilent/21031987CD31 Open set_property -dict { PACKAGE_PIN D19  IOSTANDARD LVCMOS33 } [get_ports { uart_rtl ¢_txd }];
set_property -dict { PACKAGE_PIN A3 IOSTANDARD LVCMOS33 } [get_ports { uart_rtl @ rxd }1;

w e

v {8 xc7a100t 0(1) Proegrammed
IE XADC (System Mc

o Export Hardware

| Export hardware platform for software development tools.
Hardware Device Properties ?2 00O X : /

-

Include bitstream

Exportto: | = <Local to Project> ~

) Export to
=/

ties

TclConsole  x Messages Serial I/0 Links Serial I/0 Scans

Qa z £ 11 B B O

i set_property PROGRAM.FILE {/home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SoC.Tuns/impl_1/design_1_wrapper.bit} [get_hw_devices xc7aleet_e]
program_hw_devices [get_hw_devices xc7a1eet_o]

INFO: [Labtools 27-3164] End of startup status: HIGH

refresh_bw_device [lindex [get_hw_devices xc7al@@t_g] @]

INFO: [Labtools 27-1434] Device xc7al@®t (JTAG device index = @) is programmed with a design that has no supported debug core(s) in it.

Export a hardware description file for use with the SDK
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oftware Implementation (2)

« Launch SDK (File/Launch SDK

Edit Flow Tools Reports Window Layout View Help Q- Quick A write_bitstream Complete

E B X b

LI - I Dashboard ~ Default Layout ~
HARDWARE MANAGER - localhost/xilinx_tcf/Digilent/210319B7CD3CA ? X

@ There are no debug cores. Program device Refresh device

Open Block Design

Generate Block Design Hardware ? 00X constraintxdec 200 X
Q = = o X B B X N E Q o
~ SIMULATION e Status set_property -dict { PACKAGE_PIN E3  IOSTANDARD LVCMOS33 } [get_ports { clk_180MHz }] ~
Run Simulation « ¥ localhost(1) Connected set_property -dict { PACKAGE_PIN C2 TOSTANDARD LVCMDS33 } [get_ports { reset_rtl @ }
~ M@ xilin_tcfiDigilent/210319B7CD31 Open set_property -dict { PACKAGE_PIN D1@  TOSTANDARD LVCMDS33 } [get_ports { uart_rtl_e_txd }]:
v RTLANALYSIS « # xc7a100t0(1) Programmed set_property -dict { PACKAGE_PIN AG TOSTANDARD LVCMOS33 } [get_ports { uart_rtl & rxd }];
> Open Elaborated Design IE XADC (System Mc .
v SYNTHESIS H
P Run Synthesis :
> Open Synthesized Design - o unch S
£ 2 . Launch software development tool.
~ IMPLEMENTATION : '
» RunImplementation Hardware Device Properties. 2 00X
~ OpenImplemented Design o :
Exported location: |« <Local to Project>
Constraints Wizard H
Edit Timing Constraints : Workspace: = <Local to Project= -
@ Report Timing Summary :
Report Clock Networks
Report Clock Interaction '
Repert Methodology !
Report DRC :
Report Utilization : ~
< b3
& Report Power
"4 Schematic Tcl Console  x Messages | Serial I/O Links | Serial I/0 Scans 2 _00O
a = 2 B B @O
~ PROGRAM AND DEBUG refresh_hw_device [lindex [get_hw_devices xc7alg@t_p] @] ~
1 Generate Bitstream INFO: [Labtools 27-1434] Device xc7al@@t (JTAG device index = @) is programmed with a design that has no supported debug core(s) in it.
file mkdir /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SNN_UART_SoC.sdk
~ Open Hardware Manager 1 file copy -force /home/doanh/Work/FPGA_SNN/FPEA/SHN_UART_SoC/SNN_UART_SoC.runs/impl_1/design_1_wrapper.sysdef /home/doanh/Work/FPGA_SNN/FPGA/SNN_UART_SoC/SHN_UART_SoC.sdk/design_1_wrapper.hdf
Open Target
' v

Program Device < >

Add Configuration Memery D M

Launch Hardware
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Software Implementation (3)

C t l \ | . t. I . t . S D K
File Edit Navigate Search Project Run Xilinx Window Help ‘
o IR SRR R IR N B - Nl B R SR
New Project
By xplorer & =% [ ¥ 7 = O | |3 system.hdf 18
X . o * Application Project v |
¥ [} > design_1_wrapper_hw_platform_0 [FPGA_SNN main design_1_wrapper_hw_platform_0 Hardware Platform Specification
. . Create a managed make application project.
- = design_1_wrapper.bit
Design Information
=i design_1_wrapper.mmi —_—
B Target FPGA Device: 7a100t Project name: ‘hello,world
Part: xc7a100tcsg324-1
Created With: Vivado 2019.1 Lidlisaudataulslasati
Created On: Wed Sep 13 14:44:20 2023 Location: |»"homerdoaﬂh»‘\r‘-.'olk»‘FPGA,S\\»‘FPGMS\ N_UART_SoC/SNI Browse...
Address Map for processor microblaze_0 Choose file system:  default
Cell Base Addr High Addr Slave I/f Mem/Reg 0S Platform: standalone - |
SNN_top_0 0x44a00000 0x44a0ffff s_axi REGISTER
i Target Hardware
axi_uartlite_0 0x40600000 | 0x4060ffff S_AXI REGISTER
H Hardware Platform: design_1_wrapper_hw_platform_0 v| New.
microblaze_0_local_memory 0x00000000 | 0x0001ffff SLMB MEMORY
: Processor: microblaze_0 v |
Address Map for MDM mdm_1
Target Software
Cell Base Addr | High Addr slave I/f Mem/Reg Language: ®c Oc++
Compiler: 32-bit o/
IP blocks present in the design Hypervisor Guest: N/A v
rst_clk_wiz_1_100M proc_sys reset 5.0 Board Support Package: @ Create New |hel|o,world,bsp
microblaze_0_local_memory_dimb_bram_if_cntlr Imb_bram_if_cntlr 4.0
clk_wiz_1 clk_wiz 6.0 Use existing v
mirrnhlaze 0 lacal meman: ilmh_hram_if_cntle_Imb_hram if eofle_an =
Overview
44 Target Connections 2 4 4% = B8 ||[2 Problems 52| & Tasks B Console [ Properties B SDK Terminal ~ C BEB=0
b (= Hardware Server 0 items B |
. i i 5 Iviork /FPGA_S
b & Linux TCF Agent Descripf Resource Path Location @ <Back Next> e ‘ “ ! -
b (> QEMU TcfadhClient ~ @ 1
14:53:27 INFO : Successfully done setting SDK workspace
14:53:27 INFO : Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FF
il o L 2l

3 design_1_wrapper_hw_platform_o0/system.hdf
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Software Implementation (4)

« Make your own software

File Edit Navigate Search Project Run Xilinx Window Help ‘

- B/ - F-O0- wnD D@ S e O - P - Quick Access || ® [|@&
I3 Project Explorer &2 E&%|¥Y ¥Y=n1 3 system.hdf Hh System.mss [& helloworld.c & = A | E= outline ¥ TDocume @ MakeTar = O
< (#F > design_1_wrapper_hw_platform_0 [FPGA_SNN main] #include <stdie.h> — R R e ¥ Y
. } #include "platform.h" . .
> design_1_wrapper.bit #include "xil_printf.h" u stdioh
= design_1_wrappermmi #include "xuartlite_1.h" o platform.h
> system.hdf #define UARTLITE_BASEADDR XPAR_UARTLITE_@_BASEADDR o xil_printf.h
~ (5> hello_world [FPGA_SNN main] . o xuartlite_Lh
: : #define SNN_BASE_ADDRESS ©x44200000
b Binaries #define SNN_STATUS (SNN_BASE_ADDRESS) # UARTLITE_BASEADDR
b i Includes #define SNN_SPIKEQ (SHNN_BASE_ADDRESS + 0x0d) # SNN_BASE_ADDRESS
#define SNN_CONFIG (SNN_BASE_ADDRESS + @x08)
b @y > Debug #define SNN_MUMBER (SMN_BASE_ADDRESS + @x@cC) # SNN_STATUS
~ g sre R . . # SNN_SPIKEQ
static inline void reg_write32(uint32_t addr, uint32_t data) {
D volatile uint32_t * ptr = (velatile uint32_t *) addr; # SNN_CONFIG
*ptr = data;
b [ platform_config.h N ptr ata # SNN_NUMBER
b [ platform.c osreg_writsaztuintsz_l, uint32_t) : void
static inline uint32_t reg_read32(uint32_t addr) ¢ 5 N
b : N - — . T @ 5 reg_read32(uint32_t): uin
[ platform.h volatile uint3z_t * ptr = (volatile uint32_t *) addr; 9 ( )
T Iscript.ld return *ptr; e main():int
} -
b ({# > hello_world_bsp [FPGA_SNN m
int main()
{
init_platform();
print("Hello World\n\r"
for (int i = 0; 1 < 408; i++) {
Teg_write32(SNN_CONFIG, @x1);
xil_printf("SPIKE loading . . . #%d\n", i);
for (int j = @; j < 100000; j++) {
uint32_t temp = reg_read32(SNN_STATUS); =l
[l [x]
44 Target Connections 3 4 4% = 0 |[f problems 52 | Tasks & console [ Properties = SDK Terminal ¥ = 0O [E|sbkLog % =g
» = Hardware Server 1items 14:53:26 INFO  : Registering command handlers for SDK TCF services
fieii i 153 H hing XSCT server: xsct -n -interactive /home/doanh/Work/FPGA_S
b Description Resource Path Location 7 14:53:26 INFO Launc =
£ Linux TCF Agent H || 14:53:26 INFO XSCT server has started successfully.
b = QEMU TefGdbClient b i Infos (1 item) {1 14:53:26 INFO  : Successfully done setting XSCT server connection channel
14:53:27 INFO : successfully done setting SDK workspace
14:53:27 INFO Processing command line option -hwspec fhome/doanh/Work/FPGA_SNN/FF
(| ) | [ 0|
Writable SmartInsert | 22:2
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Software Implementation (5)

Build & Run Configuration & Apply & Run

File Edit Navigate Search Project Run Xilinx Window Help

B-Q- @i -0 - WD RBPEE YA E D liwwccm.@

Iy Project Explorer &

B &

~ (3% > design_1_wrapp
Create, manage, and run configurations
= > design_1_wra
Run or Debug a program using System Debugger.

=4 design_1_wrapj

> system.hdf XD -

Name: ‘System Debugger using Debug_hello_world.elf on Local

ype filter text @ Target Setup . [[] Application| ®- Arguments B Environment, £ Symbol Files| &~ Source| & Path Map| =] Common

A Performance Analysis =
? @ Includes o Debug Type: Standalone Application Debug | ¥ ‘
b 3> Debug |5 Target Communication Framework
i) . .
o e £, Xilinx C/C++ Application (GDB) Ezpnesieng | Lo | new
£ ilinscicas annlicati omuRah MU
b .
5 helloworld.c - o Hardware Platform: design_1_wrapper_hw_platform_0 v ‘
b (5 platfor ~ %; Xilinx C/C++ application (System Debugger)
i}
t Bitstream File: ‘design_‘\_wrapper.bit Search... | Browse... ‘ Generate...
b [ platfor L
> [ platform.h Initialization) File: ‘ Search... | Browse... ‘
Rlseriptid FPGA Device: ‘Autu Detect Select...
b [ > hello_world_bsg
PS Device: Auto Detect Select...
i d
Reset entire system mmary of operations to be perform L
ollowing operations will be performed before launching the debugger.
Program FPGA . Program FPGA fabric (PL). =l
KT I ‘
; B Reve! Apply
Filter matched 6 of 9 items 3 el
':'_7:‘ Close | Run
4 Target Connections & + 4% = O |[fl Problems % I Tasks E Console T Properties = SDK Terminal ¥ = 0 |[ElsbKlog = s = o
» = Hardware Server 1 items 14:53:26 INFO Registering command handlers for SDK TCF services
B Fi o 14:53:26 INFO : Launching XSCT server: xsct -n -interactive /home/doanh/Work/FPGA_S
(= Description Resource Path Location 1 =
£ Linux TCF Agent - - H H 14:53:26 INFO : XSCT server has started successfully.
b = QEMU TcfGdbClient b i Infos (1 item) i i 14:53:26 INFO  : Successfully done setting XSCT server connection channel
14:53:27 INFO : Successfully done setting SDK workspace
14:53:27 INFO : Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FF
51 o O]

Ef hello_world
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Software Implementation (6)

Using UART display with baud rate of 115200

[l & ~/Work/SNN_FPGA/FPGA/SNN_UART_SoC/SNN_UART_SoC.sim/sim_1/behav/xsim
[ ssword for doanh:

)+ Ctrl+T followed b
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Flash memory configuration (1)

1. Generate a bitstream from block diagram in Vivado and export the hardware definition file (system.HDF)

2. Open SDK and define a new application project called app.ELF, based on system.HDF which was just exported from Vivado. Create it as
a blank project.

3. Generate linker Script and ensure that all of the 'Section to Memory Region Mapping' sections are loading from DDR.
4. Place all C application files in the src directory and build the .ELF (Default behaviour is automatic build).

5. Still in SDK and using the xcst console, enter the following command.

mb-objcopy -O srec app.elf app.srec

- This simply takes the app.ELF and converts it to app.SREC. This SREC format is a bootable format to store in flash
6. Create a new application project, using the same .HDF. This will be a 'SREC SPI Bootloader' application project.

7. Generate linker script for this SREC Bootloader and ensure that all of the sections load from iimb (BRAM).

8. Navigate to the blconfig.h file in the src directory for the SREC bootloader and set a value for FLASH_IMAGE_BASEADDR.
- The value which you set should be as follows.

FLASH_IMAGE_BASEADDR = Flash_base_address + OFFSET.

- The Flash_base address is viewable in your linker script for your app.ELF.

9. Go back to Vivado and in your block diagram, associate the app.ELF file with the design. Ensure that you update your associated ELF
file so that it is using your app.ELF rather than mb_bootloop_le.elf.

10. Re-generate the bitstream. This will initialise your BRAM with the app bootloader. This should produce a fresh system.bit file.
11. Generate the memory configuration files (app.mcs) for programming to your Flash device.

data_files = app.SREC ; bit_files = system.bit

12. Program the configuration device with app.mcs and specify the address range to be 'Entire configuration memory device'.

13. Once this has finished, you will need to right click on your device in hardware manager and click ‘Boot from configuration memory
device'.
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Flash memory configuration (2)

« Generate a bitstream from block diagram in Vivado and
export the hardware definition file (system.HD

Edit

Fow Tools Reports Window Layout View Help Q- Quick A

o8 X

write_bitstream Out-of-date  details w4

Default Layout -
Vavigator PROJECT MANAGER - SNN_Demo 2 x
PROJECT MANAGER §
Sources 2 00X Project Summary 200X
£+ settings
Q = = + £ oOverview | Dashboard
Add Sources
+ = DesignSources (4) ~
Language Templates ©. design 1 wrapper(<esion | -‘ sedtings o
F s o 1. Select export hardware
> [ Constraints (1) Project location: /homerdoanh/Work/FPGA_SNN/FPGA/SNN_Demo "
~ IPINTEGRATOR > Simulation Sources () Prodiuct family At d f. .t.
Create Block Design > [ Utility Sources Project part: X7a100tcsg324-1 e Inl |On
open Elock Design Top module name:  design 1. wrapper
Target language: Verileg
Generate Block Design
Simulator language:  Mixed
~ SIMULATION
Fun simulation Sources  Libraries  Compile Order Synthesis Export Hardware Implementation Summary | Route Staus
Properti . Status: Export hardware platform for software development tools. Status: 4 Out-of-date
~ RTLANALYSIS roperties ?-0@GEX Messages [ Messages 18 warnings
> Open Elaborated Design o Active run: Active run: impl_1
Part; Include bitstream Part XC7a100tcsg324-1
© SYNTHESIS Strategy: ‘ | Strategy: Vivado Implementation Defaults
Report Stra Exportto: | e <Local to Project A Report Strategy: Vivado Implementation Default Reports
P Run Synthesis
Incremente Incremental implementation: None
> Open Synthesized Design )
DRC Violations Timing setup | Hold | Pulse width
~ IMPLEMENTATION
» RunImplementation Summary: @ &warnings Worst Negative Slack(WNs): 3385 ns
Implemented DRC Report Total Negative Slack (TNS): ons
> OpenImplemented Design
Number of Failing Endpoints: 0 v
~ PROGRAM AND DEBUG TclConsole | Messages | Log | Reports | DesignRuns  x 2 _O0@
i Generate Bitstream > a
Q = = + %
> Open Hardware Manager Name Constraints  Status WNS TNS WHS THS TPWS TotalPower FailedRoutes LUT FF BRAMs URAM DSP  Start Elapsed  RunStrategy Report Stri
~  synth.1aciive]  constrs.1  synth_design Complete! 0 o 0o 0 0 9/15/23,537PM 000018 Vivado Synthesis Defaults (Vivado Synthesis 2019) Vivado sy
« impl1 constrs_1 Implementation Outof-date 3385 0.000 0025 0000 0.000 0.286 0 1044 454 625 0 3 o/5R3602PM 000140 Vivade Defaults (Vivado 2019)  VivadoImy
~ [ Qut-of-Context Module Runs
> + design_1 Submedule Runs Complete /15123,535PM  00:01:40
< >
Export a hardware description file for use with the SDK
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Flash memory configuration (3)

« Launch SDK & create new SREC SPI bootloader app.

e a:lit Navigate Search Project Run Xilinx Window Help 2 G New Project

DB/ - B 2P@EE %0 4 % & | Templates ﬁ Quc<,&(cess:§|%

e Create one of the available templates to generate a fully-functioning

plorer £3 BE®[¥Y ¥=8 |53 system.hdf L, sYS licati ect = B | Bz outline ¥ T Docume @& MakeTar = B
- application project. — -
b (%> design_1_wrapper_hw_platform_0 [FPGA_SNN main] 8] EER o ¥ ¥
. Available Templates: o stdioh =
P 5 hello_world [FPGA_SNN main] i 3 - - = stdio. —
ﬂnclude <mm;.r Dhrystone Simple bootloader for loading SREC — )
b CF hello_world_boot [FPGA SNN main] #include <stdlib. images from non volatile mema = stdlib.h
) #include <string. | Empty Application ges! v .
b # hello_world_boot_bsp [FPGA_SNN main] #include "blconfi (SPI). This program assumes that you o string.h
b @ hello_world_bsp [FPGA_SNN main] #include "portab. | Hello World have an SREC image programmed into 4 blconfigh
- #include "errors. ||wIp Echo Server SPI flash already. The program also
#include "srec.h” . assumes that the target SREC image is o portab.h
#include <xilisf. |IWIP TCP Perf Client an application for this processor that u errors.h
IWIP TCP Perf Server does not overlap the bootloader and
f= Defines 9 \WIP UDP Perf Client resides in separate physical memory in & srech
#define cR the hardware. Typically this application o xilisth
< 1+ Coment the | ™" UDF Pt Serer sinitalzed nto Bram sothaic |, ., @
{ J#def v ootloads the image when the L }
//#define VERBOSE | Memory Tests FpGA is powered up 443 display_progress(uint32_) : void
Peripheral Test :
1* Declarations * eripheral Tests ++° load_exec() : uinta_t
stat?c vu_ud disp. Upr_:late the s_erlal,ﬂas_hja_r_nlly.and ) 145 flash_get_srec_line(uints_t*) : uints_t
static uints_t 1 serial_flash_interface in xilisf library in I
static uints BSP settings! ++ init_stdout() : void
extern void # SPI_DEVICE_ID
Cy— Don't forget to modify blconfig.h to ISF SPT SELECT
f* Declaratiog reflect the offset where your SREC # -
2/ #warning "Set you N N N
#define SPI_DEVIC image resides in non-volatile memory! # 1SF_PAGE_SIZE
@ 7 Isf: XIsf
o+ -
* The following @5 Spi: XSpi
* to select the | ® ReadParam : XIsf_ReadParam
* connected to t =
w4 " TransferInProgress : volatile int
#define ISF_SPI_S @ IsfwriteBuffer : uz[]
=l ;
[ — L] © Readsuffer : u{] =
44 Target Connections 2 # 4® = B ! Problems ¥ Tasks | @ <Back Next > =
b = Hardware Server No consoles to display a : Registering command handlers for SDK TCF services

: Launching XSCT server: xsct -n -interactive /home/doanh/Work/FPGA_S
: XSCT server has started successfully.

: Successfully done setting XSCT server conmection channel

: Successfully done setting SDK workspace

: Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FF
13:11:59 INFO : Checking for hwspec changes in the project design_1_wrapper_hw_plat

b = Linux TCF Agent
b = QEMU TcfGdbClient

| —

[ |

Writable Smart Insert | 54:1
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Flash memory configuration (4)

« Modify BSP settings of SREC SPI bootloader app.

File Edit Navigate Search Project Run Xilinx Window Hel

@ - @& - w % 3 22 @ @ % - O Boardsupport Package Settings m}) Quick Access

Control various settings of your Board Support Package. e . .
3. Select .xilisf option in
Configuration for library: xilisf Ove rVieW tab ]

[t Project Explorer &3 %Y =9

b (3% > design_1_wrapper_hw_platform_0 [FPGA_SNN main]

¥ Overview

b &f hello_world [FPGA_SNM main]
~ standalone
b L& hello world boot [FPGA SNN main] Name r Default Type Description
~ {# hello_world_boot_bsp [FPGA_SNN main] I —_— serial_flash_family L 5 1 integer Indicates the Serial Flash
b i BSP Documentation . serial_flash_interface 1 1 integer Indicates the Serial Flash
microblaze_0o
b (% microblaze_0
n | 1
¥ hello_world_bsp [FPGA_SNN main]
b i BSP Documentation
by microblaze_0
Makefile
@ and
[ system.mss exit.
L ]
[ I O]
44 Target Connections 2 &£ 2 = g B =0
M
b = Hardware Server @ ommand handlers for SDK TCF services

server: xsct -n -interactive /home/doanh/Work/FPGA_S

b Li
(= Linux TCF Agent as started successfully.

b = QEMU TefGdbClient 13:11:59 INFO  : Successfully done setting XSCT server connection channel
13:11:59 INFO : successfully done setting SDK workspace
13:11:59 INFO : Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FF
13:11:59 INFO : Checking for hwspec changes in the project design_1_wrapper_hw_plat
[ 0|

9/19/2023 Ngo-Doanh Nguyen 40




Flash memory configuration (5)

* Change FLASH_IMAGE_BASEADDR = 0x003D0900 *

File Edit Navigate Search Project Run Xilinx Window Help ‘

f-ER e -&  RVDSDEE E-0 - [Hec- - Quick Access || & | [E]
[ Project Explorer 2 5 %[ ¥ ¥ = O |asystem.hdf [ system.mss helloworld.c [ system.mss | [il biconfig.h 8 | [£ bootloader.c = O | £ outline 8 T Docume @ MakeTar = O
> ({1 > design_1_wrapper_hw_platform_0 [FPGA_SNN main] ®* Copyright (C) 2004 - 2015 xilinx, Inc. All rights reserved.D B B3R e k T
- . //#warning "Please provide the correct address value for the definition FLASH_TMAGE_BASEADDR. Please give the flash offset @ i
b (=f hello_world [FPGA_SNN main] # FLASH_IMAGE_BASEADDR
5 hello_world_boot [FPGA_SNN main] I 1 #define FLASH_IMAGE_BASEADDR @x003D0080

b il Includes
b = Debug

P (= Release

= asIo

* I blconfig.h

P[4 bootloader.c
>[5 errors.h
b [ platform_config.h
b [ platform.c
> [f portab.h
b [#l srec.c
b [ srec.h
T Iscript.ld
b ¥ hello_world_boot_bsp [FPGA_SNN main]

b ¥ hello_world_bsp [FPGA_SNN main]

(K1}

k1] | ]
4 Target Connections 5 & 4% = @ |7 problems i Tasks & Console % [ Properties E SDK Terminal = B - - = 0 [lsDkLog % B =0
b (= Hardware Server No consoles to display at this time. 13:11:59 INFO  : Registering command handlers for SDK TCF services
o INFO : Launching XSCT server: xsct -n -interactive /home/doanh/Work/FPGA_S
s -
£ Linux TCF Agent INFO  : XSCT server has started successfully.
b = QEMU TefGdbClient INFO  : successfully done setting XSCT server connection channel
INFO  : Successfully done setting SDK workspace
INFO : Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FF
INFO  : Checking for hwspec changes in the project design_1_wrapper_hw_plat
A I IO}

* Apply for Arty A7 100T; Different FPGAs required different address; wiable [ smartinsert | 35:1
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Flash memory configuration (6)

Generate linker script & assign to ilmb_bram

File Edit Navigate Search Project Run Xilinx Window Help

{5 Project Explorer 3 HE]¥Y ¥ =8
b (#%> design_1_wrapper_hw_platform_0 [FPGA_SNN main]

b fhello_world [FPGA

S nain

3 Binaries

-

[ Includes

-

(= Debug

-

(= Release
¥ Eysre
b [r blconfig.h
b [# bootloader.c
b [k errors.h
b [ platform_config.h
b [5 platform.c
b [r portab.h
b [ srec.c
b [k srec.h
W Iscript.id
% hello_world_boot_bsp [F
% hello_world_bsp [

-

-

44 Target Connections 2 &£ 48 =08
P (= Hardware Server

b = Linux TCF Agent

b = QEMU TcfGdbClient

=5 hello_world_boot

9/19/2023

-/ - w DR EE %0

'3F Generate linker script
Lil Control your application's memory map.

Al
n [Output Settings

Project: hello_world_boot

>

W | Qutput Script:

Generate a linker script

Basic |Advanced|

Place Code Sections in:

» }JN,Demo.’SNN,Demo.5dklhelIo,world,bootisrclls:ript.ld Browse

_r Modify project build settings as follows:

Place Data Sections in:

Place Heap and Stack i

‘mi(mbIaze,O,Iu(aLmemury,ilmb,bre hd

‘microbIaze,o,local,memory,ilmb,b =~

5 ‘mi(mbIazE_D_Iu(al_msmury_ilmb_bri hd

1KB

1KB

Set generated script on all project build configurations b ‘ Heap Size:
St Hardware Memory Map Stack Size:
St || Memory Base Address| Size ‘
Hi || microblaze_0_local_memory 0x00000000 128 KB
Se
L]
} Fixed Section Assignments
Sul
18]
No

\

Ngo-Doanh Nguyen

Cancel

2= Qutline % £ Docume

=1 An outline is not available.

Quick Access |

@ Make Tar

= 8

1. Right click & Select
generate linker script

rted successfully.

BR=08

er: xsct -n -interactive /home/doanh/Work/FPGA_S

etting XSCT server connection channel

etting SDK workspace

e option -hwspec /home/doanh/Work/FPGA_SNN/FF
nges in the project design_1_wrapper_hw_plat

fnments and sizes from elf file: /home/doanh/

|
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Flash memory configuration (7

 Re-do step 4 & step 6 for your application project.

File Edit Navigate Search Project Run Xilinx Window Help

| A -hwDRPREES 0O Quick Access 1| B2 [[ER
[25 Project Explorer 2 = % | ¥ ¥ = O |lgsystemhdf [ systemmss  [c helloworld.c (4 system.mss  [u blconfigh  [¢ bootloaderc W Iscriptld 2 = B  Zoutline X TEDocume @ MakeTar = O
] Linker Script: Iscript.ld M
=1 An outline is not available.
Alinker script is used to control where different sections of an executable are placed in memory. =
3 Binaries In this page, you can define new memory regions, and change the assignment of sectionsto memory regions.
b il Includes
Available Memory Regions
b (= Debug ¥ Reg
¥ ysre Name Base Address Size Add Memory..
b [r data.h microblaze_0_local_memory_ilmb_bram_if_cntlr_K 0x50 0x1FFBO
> [# helloworld.c
b [ platform_config.h Stack and Heap Sizes
4 latform.c .
e Stack Size [0x400
> [ platform.h
. Heap Size |0x0
T Iscript.ld
b & hello_world_boot [FPGA_SNN main] Section to Memory Region Mapping
hellomodd boot hsp (Eifa st Section Name Memory Region
# hello_world_bsp [FPGA_SNN main] I text microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microblg
.init microblaze_0_local_memeory_ilmb_bram_if_cntlr_Mem_microbl:
fini microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢
.ctors microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microble
.dtors microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢
.rodata microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microble
.sdata2 microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢
.5bss2 microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microble =
summary Source
4 Target Connections & & 42 = 8 |/l Problems v Tasks & Console % [ Properties & SDK Terminal = B -7~ = B8 |ElsbkLog % = B8
b = Hardware Server No consoles to display at this time. 13:11:59 INFO  : Launching XSCT server: xsct -n -interactive /home/doanh/Vork/FPGA_S
N 13:11:59 INFO © XSCT server has started successfully.
(=1
£ Linux TCF Agent 13:11:59 INFO : successfully done setting XSCT server connection channel
b (= QEMU TcfGdbClient 13:11:59 INFO @ Successfully done setting SDK workspace
13:11:59 INFO : Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FF
13:11:59 INFO : Checking for hwspec changes in the project design_l_wrapper_hw_plat
13:24:00 INFO : Inferring section assignments and sizes from elf file: /home/doanh/
[ | 0|

£ hello_world
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Flash memory configuration (8)

* Generate .SREC file from .ELF file of your application

File Edit Navigate Search Project,

ilin | window Help

I IR SR S -0 - D Quick Access w E
I Project Explorer 2 =2 & [¥ ¥ = @ |gsystemhdf [ systemmss [d helloworldc | system.mss  [n biconfigh [ bootioaderc |l Iscriptld 5 = B = outine X Docume @ MakeTar = O
> (7§ > design_1_wrapper_hw_platform_0 [FPGA_SNN main] Linker Script: Iscript.ld 7
N ; An outline is not available.
= FPGA_SNN ma " S . .
¥ Gihello_world [FPGA S ain. Alinker scriptis used to control where different sections of an executable are placed in memory.
> 4 Binaries In this page, you can define new memory regions, and change the assignment of sectionsto memory regions.

b EiIncludes
- & Debu Available Memory Regj bash --noprofile --norc
9 bash-5.15 wb-objcopy -0 srec hello_world.elf hello_world.srecll

b = sre
b %5 hello_world.elf - [nonefle]

Add Memory.

microblaze_0_locs
= hello_world.elf.size

= hello_world.srec Stack and Heap Sizes

1. Select launch shell from
om:kE?'e ) stack SizeW il
@ objects.ml| HeapSize’OXE)— XIIInX tab

& sources.mk

e Section to Memory Regiol J
b E5hello_world_boot [FPGA SNN main Section Name
b # hello_world_boot_bsp [FPGA_SNN main] text i
> #hello_world_bsp [FPGA_SNN main] .init microblaze_0_local_memory_ilmb_bram_if_cntir_Mem_microbl:
fini microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢
.ctars microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢
dtors microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl:
.rodata microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢
.sdata2 microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl:
.shss2 microblaze_0_local_memory_ilmb_bram_if_cntlr_Mem_microbl¢ =l
Summary | Source
<4 Target Connections £ & & = B8 | problems < Tasks B Console %2 [ Properties & SDK Terminal B -0 - = 0 |[ElsbkLog =% BER =08
b = Hardware Server No consoles to display at this time. 13:11:59 INFO  : Launching XSCT server: xsct -n -interactive /homesdoanh/Work/FPGA_S
. 13:11:59 INFO : XSCT server has started successfully.
b = Linux TCF Agent - N
= 9 13:11:59 INFO : Successfully done setting XSCT server connection channel
b (= QEMU TcfGdbClient 13:11:59 INFO  : Successfully done setting SDK workspace
13:11:59 INFO  : Processing command line option -hwspec /home/doanh/Work/FPGA_SNN/FE
13:11:59 INFO  : Checking for hwspec changes in the project design_1_wrapper_hw_plat
13:24:00 INFO : Inferring section assignments and sizes from elf file: rhome/doanh/
(E1| | 0|

& /hello_world/src
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Flash memory configuration (9)

Window  Layout  VWiew  Help Q- Quick Acce: write_bitstream Out-of-date  details <&
® & b B & X IP Integrator v
BLOCK DESIGN - design_1 2? X%
~ PROJECT MANAGER
Sources | Design x Signals 2 _00 IP Catalog x ProjectSummary x 200 Diagram  x Address Editor 200
£ Settings
a = H o Cores | Interfaces Q a ¥ O Q ¢ |+ E o» C a9 L -3
Add Sources
1. Select Associate .ELF
s . . Select Associate .

4F 1P Catalog > Interface Connections Search:

S e . files from Tools tab

~ IPINTEGRATOR > Nets > User Repository (/home/doz rk/FPGA_SNN
Create Block Design » % axi_quad spi 0 (X1 Qu [ Vivado Repository
> F axi_vartlite_0 (AxI ot d — micrakiase 0 focal e
Open Block Design - ) x B Associate ELF = v
> T cliowiz 0 (C ! }M‘ I’_A-}I_H
A —
Generate Block Design > . Associate an ELF file with a processor instance (Address Map). ELF files are ‘CrOBlaZe +
5 ¥ microblaze_0 (I | available after running generate on your embedded design sources. ' — wxglme
: = s 0
v SIMULATION > [¥] microblaze_0_axi_periph 1 | 5 mecrctiaae, 0, ) pedgh
Run Simulation > [E] microblaze 0 local_memory . ELFFile Associations. £ i
- " e - I ~ | > —n
: Processors/Address Maps Associated ELFFile —_— .é.
~ RTLANALYSIS Properties ? 00X ] ~ @ Design Sources EaY™]
> Open Elaborated Design o ] v design_1_i
2 ; & microblaze_0 hello_world.elf
~ SYNTHESIS ~ [ Simulation Sources
D v [osim

P Run Synthesis

~ i design 1
> Open Synthesized Design esign_1_i

48 microblaze_0 hell_world.elf

ttosee

Ny T— 2. Find & Choose your

P Run Implementation

oy H
> OpenImplemented Design \ Cancel . E L F fl IeS

)

~ PROGRAM AND DEBUG TclConsole  x Messages |Log | Reports | Design Runs 2 _0O00n
¥ Generate Bitstream QT 2Nl B ®E @

> Open Hardware Manager Adding component instance block -- xilinx.com:ip:lmb_bram_if_cntlr:4.@ - ilmb_bram_if_cntlr A
Adding component instance block -- xilinx.com:ip:blk_mem_gen:8.4 - Imb_bram

Adding component instance block -- xilinx.com:ip:mdm:3.2 - mdm_1

Adding component instance block -- xilinx.com:ip:proc_sys_reset:5.8 - rst_clk wiz_@_sem

Adding component instance bleck -- xilinx.com:ip:axi_interconnect:2.1 - microblaze_@_axi_periph

Adding component instance block -- xilinx.com:ip:axi_cresshar:2.1 - xbar

Successfully read diagram <design_1> from BD file </home/doanh/Work/FPGA_SNN/FPGA/SNN_Demo/SKNN_Demo.srcs/sources_1/bd/design_1/design_1.bd>

Associate ELF Files
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Flash memory configuration (10)

* _Re-generate Bitstream & export it

w Edit  Flow Tools Reports  Window  Layout View  Help
.‘ ® b W XN BB & T
Flow Navigator IMPLEMENTED DESIGN - xc7a100tcsg324-1
A
Generate Block Design Sources | Netlist i B
il
= A

v SIMULATION

write_bitstream Out-of-date details &

Default Layout ~

v tealdds @XC

design_1_wrapper Save In: SNM_Flash_SaC
Run Simulation 5 & Nets (29)
N Leaf Cells (9] SNN_Flash_SoC.cache
~ RTLANALYSIS 3 design_1.i (de SNN_Flash_SoC.hw
> Open Elaborated Design SNN_Flash_SoC.ip_user_files
SNN_Flash_SoC.runs
+ SYNTHESIS SNN_Flash_SoC.sdk

SNN_Flash_SoC.sim

Run Synthy
P Run Synthesis SNN_Flash_SoC.srcs

> Open Synthesized Design

~ IMPLEMENTATION
P Run Implementation

~ Open Implemented Design

Recent Directories

thome/doanh/Work/FPGA_SNN/FPGA/SNN_Flash_SoC v

File Preview

File: system.bit
Directory: /home/doanh/Work/FPGA_SNN/FPGA/SNN_Flash_SoC
Created: Friday 15.09.23 04:23 PM
Accessed: Friday 15.09.23 04:23 PM
Modified: Friday 15.09.23 04:23 PM
Size:3.6 MB

Type: Bitstream file

Owner: doanh

Permissions: rw-r-r—

2. Select export bitstream

co e from export tab
Edit Timing Constraints
@ Report Timing Summary
Report Clock Networks
Report Clock Interaction
Report Methodology ile name: systermn.bit I
Report DRC Files of type:  Bitstream Files (.bit) -
Report Noise —
Report Utilization 9
& Report Power Tcl Console | Messages | Log | Reports | Design Runs | Power | DRC | Methodology | Timing x 2 _00G
¥4 schematic aQa T = : Design Timing Summary
General Information ~ ~
~ PROGRAM AND DEBUG Timer Settings Setup Hold Pulse Width
Design Timing Summary Worst Negative Slack (WNS):  2.385 ns Worst Hold Slack (WHS): 0.025ns Worst Pulse Width Slack (WPWS): 7.000ns
o " Open Hardware Manager Clock Summary (5) Total Negative Slack (TNS):  0.000ns Total Hold Slack (THS): 0.000 ns Total Pulse Width Negative Slack (TPWS):  0.000 ns
> fe Check Timing (12) Number of Failing Endpoints: 0 Number of Failing Endpoints: 0 Number of Failing Endpoints: 0
Open Target -
" E > @ Intra-Clock Paths Total Number of Endpeints: 14008 Total Number of Endpeints: 14008 Total Number of Endpoints: 4924
Pregram Device Inter-Clock Paths B . R
£ ~  All user specified timing constraints are met. ~

Timing Summary - impl_1 (saved)

Export Bitstream File

9/19/2023
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Flash memory configuration (11)

« (Generate memory configuration file

Open Block Design

Generate Block Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

> Open Elaberated Design

<

SYNTHESIS
P Run Synthesis

> Open Synthesized Design

<

IMPLEMENTATION
P RunImplementation
~ Open Implemented Design
Constraints Wizard
Edit Timing Constraints
T Report Timing Summary
Report Clock Networks

Report Clock Interaction

Repert Methodology
Repert DRC

Report Noise
Repert Utilization
& Report Power

»4 Schematic

~ PROGRAM AND DEBUG
M Generate Bitstream

~ Open Hardware Manager

Open Target

9/19/2023

write_bitstream Qut-of-date defails  ~&

Window  Layout View  Help Q- Quick Access
& p B X O & Z Default Layout v
IMPLEMENTED DESIGN - xc7a100tcsg324-1 ? X
Sources | Netlist 2 _00 Project Summary x| Device x 200
= A X - 0 Write Memory Configuration File 1 S I t G t M
5 Nets Create a configuration file to program the device p " e eC enera e emory
> Leaf Cells (9) C f-g t. f.I
e onfiguration files
Format: MCS v
(® Memory Part: 52511 28s0000K0-5pix]_x2_xd @‘. .
() Custom Memory Size (MB): 2 . Choose 825f| 1 28SXXXXO-Sp|_
Filename: hello_werld.mcs l EI X1 X2 X4 *
Options
5. Select your generate
Properties () Load bitstream files [~] Daisy chain configuration file

Tcl Console

General Information

Messages

Timer Settings
Design Timing Summary.

Clock Summary (5)

» s Check Timing (13
» = Intra-Clock Paths
Inter-Clock Paths

mpl_1 (saved)

T

ng Si

tem.bit

Start address: 00000000 | Direction: up ~  Bitfile: J/hom kIFPGA_

SNN_Flash_SoC,

bitstream

[+] Load data files

Start address: | 003D090C | Direction:  up

~ Datafile: |"GA/SNN_Flash SoC/SNN.Flash_Soc.sdhello_world/Debugihello_worldsrec & |-+

6. Set start address of data

Write checksum

] Disable bit swapping

L [v/] Overwrite

Command: Flash_SoC.sdk/hello_world/Debug/hello_world.srec” } -checksum -force -file "/ho

\

Number of Failing Endpoints: 0
14008

Number of Failing Endpoints: 0

Total Number of Endpoints: 14008 Total Number of Endpoints:

Ngo-Doanh Nguyen

Numnber of Fail oints:

Total Number of Endpoints:

00T; Different FPGAs required different memory parts;

files (see step 5) & Select your
generate .SREC file

VWork/FPGA_SNN/FPGA/SNN_Flash_SoC/hello_world.mes"
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« Add configuration memory device & program it

Flash memory configuration (12)

2. New target with JTAG

Eile  Edit Flow Tools Reports Window Layout View Help Q- Quick Access
= - B X » B & X » Dashboard ~
Flow Navigator HARDWARE = (_tc!

Open Block Design

Generate Block Design

<

SIMULATION

Run Simulatien

<

RTL ANALYSIS

> Open Elaborated Design

v SYNTHESIS
P Run Synthesis

> Open Synthesized Design

~ IMPLEMENTATION
P Run Implementation
~ OpenImplemented Design
Constraints Wizard
Edit Timing Constraints
9 Report Timing Summary
Report Clock Networks
Report Clock Interaction
Report Methodology
Report DRC
Report Utilization
#& Report Power

*4 schematic

~ PROGRAM AND DEBUG

i Generate Bitstream

Open Hardware Manager
Open Target

Program Device

dd Configuration Memory D
- LY

@ There are no debug cores. Program device Refresh device

Hardware ? 00X

Q = 2 &

Name Status
ocalhost (1) Connected

B+ xilinx_tcf/Digilent/210319B7CD31 DEEH

~ {8 x(7a100t.0(2) Programmed
3E XADC (System Moniter)

525fl128s0000000-spi-x1_%2_)

< >
Configuration Memory Device P 2 00X

52511 28s000000-spi-x1_x2_x4 - -]
Name:

525f11 28s30000mx0-5pi-x1_x2_x4
Memory Part: & 525f1128s3000mx0-5pi-x1_%x2 x4
Memory type: spl

Memory density: 128

Programming file: /home/doanh/Work/FPGA_SNN/FPGA/

< >
Tcl Console | Messages | Reports x Serial I/0 Links
a = £ +

Report

w Synthesis

~ Synth Design (synth_design)
& synth_1_synth_report_utilization_0
& synth_1_synth_synthesis_report_0
~ Out-of-Context Module Runs

* design 1

gi 10319B7CD3CA

x - 0 Program Configuration Memory Device

Select a configuration file and set programming options.

Memory Device:

£ 525f112853000000-5pi-x1 %2 x4

Configurajion file: |/hnme/dnanhm.rmk;FPGA,sNN/FPGA:SNN,Demoﬁheuo,wnr\d.mcs

PRM file: yme/doanh/Work/FPGA_SNN/FPGA/SNN_Dema/hello_world.prm

State of non-config mem VO pins: | Pull-none  +

2rearam.Qoerations

Address Range:

Entire Configuration Memory Device
) Erase

[ Blank Check

[ Program

[ werify

[ verify Checksum

UF Gptions

() Create SVF Only (no program operations)

Micro-AB USB

® @ [ | Senedist
Type Options Modi

6-pin JTAG

report_utilization 9/15) Header (Js)
9/15/

* AppIY'“Fm;A“rt"VW?“‘“] 00T; Different FPGAs have different setups;

9/19/2023
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frequency of 3MHz

3. Right click & Add
configuration memory device &
program

4. Select your generated
memory configuration file

6. NOTE: Before OK. Need to
change Jump JP1 on FPGA
board to JTAG*

USB-JTAG/UART Port

t USB <P UART
ﬂ Controller

JTAG
1%6 JTAG P Artix-7
- Header

SPl ¢+ Quad-SPIFlash

Port

- MO j Mode (JP1)
E =15
I
_o/"o_g ;\

Done
SPI Flash
JTAG

Prog
Programming Mode




Flash memory configuration (13)

SNN_Demo - [/home/doanh/Work/FPGA_SNN/FPGA/SNN_Demo/SNN_Demo.xpr] - Vivado 2019.1
File  Edit Flow Tools Reports Window Layout View Help Q- Quick Acc write_bitstream Complete

LI - BEDM X Dashboard «

HARDWARE MANAGER - localhost/xilinx_tcf/Digilent/210319B7CD3CA

Open Block Design @ There are no debug cores. Program device Refresh device 0 . C h a n g e J u m p J P 1 O n F P GA

~

? X

i board to SPI Flash*
Q' x & =
v SIMULATION
Name Status
Run Simulation ~ ¥ localhost(1) Connected
@ xahmd tct/Digilent/Z103T9B7CD31 Open
v RTLANALYSIS

4 xc7a100t_0 (2) Programmec

R 1. Right click & Select boot from

52511 28s0000x0-5 pi-x1_X2_3

> Open Elaborated Design

p— memory configuration device
P Run Synthesis
> Open Synthesized Design
< >
v IMPLEMENTATION
» Run Implementation Hardware Device Properties. 2 00 X%
~ OpenImplemented Design @ xc7a100t 0 &
Constraints Wizard Name: %c7a100t 0 &l
Edit Timing Constraints Part Xc73100t
G Report Timing Summary ID code: 13631003
Report Clock Networks IR lengh: 6
Report Clock Interaction
Status: Programmed
Report Methodal
B ReportMethodology Programming file: -omicfgmenm’spi_xc7a100t_pullnon
Report DRC _ - -
S —— e 2 USB-JTAGIUART Port
Report Utlization General | Properties N SP|
& Report Pover MicroEDSE: USB <> UART o 4P Quad-SPI Flash
i i i i Connector | = 4> ort
s Tcl Console | Messages | Reports x Serial 1/O Links | Serial I/0 Scans Controller
chematic (J10)
Q = & + JTAG
~ PROGRAM AND DEBUG Report Type Options Modif 1)‘6 JTAG Port .
Jit Generate Bitstream  Synthesis Head Art|x-7
cvnth desian -Di eaader
« Open Hardware Manager ~ Synth Design (synth_design) G pm JTAG : Mode (JP1)
openT 4 synth_1_synth_report_utilization_0 report_utilization ERETA Header (JB) MO
pen Target

4 synth_1_synth_synthesis_report_0

9/15/%

~ Out-of-Context Module Runs M1 ?
2

Program Device

9/19/2023 Ngo-Doanh Nguyen

SPI Flash
JTAG Prog
Programming Mode




Flash memory configuration (14)

onnect to UART display & programs automatically start.

-m serial.tool: ini yUSB1 115200

000000000000000
)0000000000000

1000000000

00000000001

)00000000000000
000000000000000

100000

00000000000000
00000000000000C
)00000000C 000

)0000007
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